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INTRODUCTION

If you're upgrading from a previous release or revision of WordStar, be sure
to read the booklet “Upgrading from a Previous Release” before you install
WordStar 7.0.

This booklet includes the following sections:

O “Installing WordStar” tells you how to install WordStar. This section also
tells you how to start and exit WordStar, how to view the README file, and
how to decompress a single file from the compressed program disks in your
package.

1 “Customizing WordStar” tells you how to modify your printer installation
and WordStar settings to suit your particular needs. This section includes a
list of the paths you can take in WSCHANGE (the WordStar customizing
option) to change various settings in WordStar.

4 “Advanced Customizing” provides more advanced procedures for
customizing WordStar, such as fine-tuning Preview, patching WordStar, and
using the PDFEDIT option. Only advanced WordStar users should use these
procedures.



CHAPTER 1

INSTALLING
WORDSTAR

This section tells you how to install WordStar using WSSETUP, the WordStar
setup program. You'll need the disks that came in your WordStar package.
Then follow the instructions below to install WordStar.
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Most hard disk computers have a floppy disk drive named A and a hard disk
drive named C. If your drives are named differently, make the appropriate sub-
stitutions in the instructions below.

1 Turn on your computer.
2 When C appears on the screen, put the Installation disk in drive A.
3 Type a: and press Enter.

4 Type wssetup and press Enter. As you install WordStar, read the instructions
on the screen.
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INSTALLING WORDSTAR

5 You may be asked if you want to modify the CONFIG.SYS file. If so, follow

10

the onscreen instructions to modify the file, and be sure to reboot your com-
puter. When you finish, restart WSSETUP by following steps 2, 3, and 4
above. If you are not asked to modify the CONFIG.SYS file, go to step 6.

At the Serial Number screen, type the serial number for your copy of
WordStar. Press F10 to continue.

At the Disk Drive Names screen, press F10 to install WordStar in the WS
directory on drive C.

At the Add or Remove a Feature screen, copy your disks. WordStar, Dic-

tionaries, and Preview are already marked with a plus sign (+) for copying.
These features contain the main program files for word processing. High-

light and mark any other features you want. Press the PgDn key to see the
complete list. Be sure to mark Printer Data Files and choose the printer(s)

you're going to install.

Note: When a feature is followed by three dots, it means you can copy all
options or selected options. If a feature is already marked with a +, press
Enter to see the options.

When you finish marking features, press F10 to start copying, and follow the
onscreen instructions for inserting disks.

Install your monitor and choose the default colors for your type of monitor.
If you have a monochrome graphics monitor or if your monitor doesn’t dis-
play underlined characters, choose the alternate monochrome display op-
tion.

Install your printer. You can install one printer in WSSETUP. That printer
becomes your default printer, the one assigned to print your documents.

(If you have other printers, you can install them later.) When you name
your printer description file (PDF) at the Installed Printer Menu, choose a
name that suits your printer. Don’t choose ASCIl, ASC256, DRAFT, or WS4.

For more information about printer installation, see “Installing a Printer” in
the “Customizing WordStar” section of this booklet.

When you finish installing your printer and you’re back at the Installed
Printer Menu, press F10 to save your PDF.



STARTING AND EXITING WORDSTAR

17  Atthe Summary screen, read the information and press F10 to return
to DOS. Remove Disk 1 from drive A.

When the DOS prompt appears, you can start WordStar.

Later on, you may decide to add more features, change WordStar settings, or
install another printer. To make additional changes to WordStar, use
WINSTALL, the WordStar program that contains options for additional installa-
tion and customization. For more information about WINSTALL, see
“Customizing WordStar” in this booklet.

S TARTING AND EXITING WORDSTAR

Once you've installed WordStar, here’s how to start and exit the program each
time you want to use it:

7 Turn on your computer.

2 Log on to the directory containing your WordStar files. For example, if
WordStar is in the WS directory, type cd\ws and press Enter.

3 Type ws and press Enter.
4 Press F to see the File Menu and begin using WordStar.

5 When you want to exit WordStar, go back to the Opening screen and
press X.

If you have any problems starting WordStar, see “Modifying the CONFIG.SYS
File” below.
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M obpIFYING THE CONFIG.SYS FILE

THE FILES= STATEMENT

During WSSETUP, WordStar checks the FILES= statement in your
CONFIG.SYS file to see if it is correct for your DOS version and WordStar. If
the FILES= statement needs to be changed, WSSETUP asks if you want the
CONFIG.SYS file to be modified. If you respond “No” to that question, you'll
have to go into the CONFIG.SYS file and make the changes yourself.

WSSETUP may continue to prompt you to modify the CONFIG.SYS file, even
though the FILES= statement is correct for your DOS version. This happens
when memory-resident programs or other items in your AUTOEXEC.BAT file
don’t leave WordStar enough room to run correctly.

To solve this problem:

= |f you have DOS 3.0 or later, increase the FILES= statement in increments of
five (rebooting after each increment) until the CONFIG.SYS prompt no
longer appears when you run WSSETUP. Probably one increase will be
enough. A second option is to remove any memory-resident programs from
your AUTOEXEC.BAT file.

= |f you have DOS 2.n or earlier, FILES=20 is the maximum that can be stated
in the CONFIG.SYS file. If the CONFIG.SYS prompt continues to appear,
even though you have a FILES=20 statement, remove all memory-resident
programs from your AUTOEXEC.BAT file. (In a normal DOS 2.n
environment, FILES=20 is enough to run WordStar properly.)

If you want to bypass the FILES= check in WSSETUP, type wssetup /z at the
DOS prompt and press Enter. Then WSSETUP will run without verifying your
FILES= statement. This method is recommended only if you're sure the
FILES= statement is adequate for your needs.

THE STACKS= STATEMENT

If you get a DOS error message like Stack Overflow or Divide Overflow, and
you're using DOS 3.2 or later, try adding STACKS=20,256 to your
CONFIG.SYS file.
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INstaLLING COMPANION PROGRAMS

If you want to add a companion program such as MailList™ or Star Exchange,
you can use the Add or remove a feature option in WINSTALL. For more infor-
mation, see “Add or remove a feature” under “The WINSTALL Menu” in

“Customizing WordStar.”

USING COPYWS TO DECOMPRESS A SINGLE FILE

The disks in your WordStar package are compressed. If you need to replace a
single file, you can decompress the file from the appropriate compressed disk.
To decompress and copy a single file from a compressed disk, follow the

instructions below.
7 Insert Disk 1 from your WordStar package into drive A. Log on to drive A.

2 Atthe A prompt, type copyws a: c:\ws filename, where filename is the
name of the file you want to decompress, and press Enter. The program tells

you what disk to insert.

3  Follow the onscreen instructions.

README—F OR THE LATEST INFORMATION

The README file contains information about WordStar that became available
after the manuals were printed. To view README, make sure you're in the
WordStar directory. Type readme.bat and press Enter. Use regular WordStar
commands to move around in or print the README file.



CHAPTER 2

CUSTOMIZING
WORDSTAR

After you install WordStar, you can customize it by changing some of its set-
tings to suit your particular needs. For example, you might want to change the
colors displayed in WordStar, or change the printer port selection for your
printer.
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You used WSSETUP to install WordStar. To customize WordStar, you use
WINSTALL. WINSTALL offers options for customizing WordStar and installing
additional features.

To find the information you need to customize WordStar using WINSTALL, see
the chart on the next page.

FINDING INFORMATION IN THIS SECTION

The following chart shows some of the items you can change in WINSTALL,
and which sections in this chapter to refer to for instructions.
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CUSTOMIZING WORDSTAR

AUTOEXEC.BAT file

Color settings
CONFIG.SYS file
Converting files

Custom printer code
Default printer

Dialog boxes (Enter key)
Directory (initial logged)
Disk drives
Downloading fonts
Fonts

Graphics

Help level

Inset®

MailList

Margins

Memory usage

Monitor

Paragraph style (default)
Pathing

Pause between pages
PDFs

Preview screen fonts
Printer drivers

Printer port

RAM usage

Screen size

Sheet feeders

Star Exchange

Tabs

WordStar settings

‘ Setting Basic Editing Defaults

Changing WordStar Settings in WSCHANGE
Setting Basic Editing Defaults

Adding or Removing a Feature

Installing a Printer

Setting Basic Editing Defaults

Setting Basic Editing Defaults

Setting Basic Editing Defaults

Changing WordStar Settings in WSCHANGE
Customizing Your Printer in PRCHANGE
Customizing Your Printer in PRCHANGE
Adding or Removing a Feature

Setting Basic Editing Defaults

Adding or Removing a Feature

Adding or Removing a Feature

Changing WordStar Settings in WSCHANGE
Managing Your Computer’s Memory
Installing a Monitor

Setting Basic Editing Defaults

Changing WordStar Settings in WSCHANGE
Customizing Your Printer in PRCHANGE
Installing a Printer

Customizing Your Printer

Installing a Printer

Installing a Printer

Changing WordStar Settings in WSCHANGE
Changing WordStar Settings in WSCHANGE
Installing a Printer

Adding or Removing a Feature

Changing WordStar Settings in WSCHANGE
Changing WordStar Settings in WSCHANGE




STARTING WINSTALL

STARTING WINSTALL

To customize WordStar, you use WINSTALL. To start WINSTALL, log on to
your WordStar directory (usually WS). Type winstall and press Enter. You see
the WINSTALL Menu.

If the monitor display in WINSTALL isn’t clear, exit the program, type
winstall /m at the DOS prompt, and press Enter.

THE WINSTALL MENU

WINSTALL

Install a monitor

Modify or install a printer (PRCHANGE)
Set basic editing defaults

Add or remove a feature

Customize WordStar (WSCHANGE>

Add fonts to custom database (LSRFONTS>
Save and return to DOS

(C> Copyright 1992 WordStar International Inc. All rights reserved.

- Directions:
F1 = Help
Start typing name = Find matching name
t !, Home, End = Move highlighting
Esc = Quit without saving <« = Select

The WINSTALL Menu offers the choices shown below.

= |nstall a monitor You installed your monitor when you installed WordStar.
You can use this option to change the type of monitor you installed. See
“Installing a Monitor.”

= Modify or install a printer (PRCHANGE) You installed a printer when you
installed WordStar. Use this option to customize how your printer works
with WordStar or to install or customize additional printers. See “Installing
a Printer.”
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Set basic editing defaults This option allows you to set some basic defaults
for WordStar. See “Setting Basic Editing Defaults.”

Add or remove a feature When you installed WordStar, you had the
opportunity to add or remove features such as ProFinder™, Star Exchange,
and MailList. You can use this option at any time to add or remove various
features to suit your needs. See “Adding or Removing a Feature.”

Customize WordStar (WSCHANGE) You can use this option to change
many WordStar settings, such as the default help level, the colors on a color
monitor, and the directory paths to different WordStar files. See “Changing
WordStar Settings in WSCHANGE.”

Add fonts to custom database (LSRFONTS) If you have a laser printer, and
you have fonts that are not listed on the font menus in PRCHANGE, first
you’ll need to use the LSRFONTS option to build a custom font database.
Then you’ll use PRCHANGE to add the fonts to your PDF. See “Adding
Custom Fonts” in “Adding Fonts to a PDF.”

Each option on the WINSTALL Menu is described in detail below.

INSTALLING A MONITOR

You installed a monitor when you installed WordStar. Use the WINSTALL
Install a monitor option if you want to change your monitor installation.

The monitor options are shown below. If you don’t know what kind of monitor
you have, choose the first option, IBM PC/Compatible. If you see snow on the
screen or experience problems while editing in WordStar, install your monitor
as the third option, IBM PC ROM/Compatible. The monitor options are

IBM PC/Compatible (includes EGA and VGA) A standard IBM PC or
compatible color or monochrome monitor that uses video RAM directly.
This installation provides the fastest display.

IBM PC CGA/Compatible An IBM PC or compatible monitor that uses
CGA video RAM directly. This installation removes most snow from the
screen.



SETTING BASIC EDITING DEFAULTS

® IBM PC ROM/Compatible This installation is for monitors that are less
than 100 percent IBM compatible. It removes snow from the screen, but
provides the slowest display.

= IBM PC EGA with 43 lines This monitor choice displays 43 lines onscreen
while editing in WordStar and then reverts to the usual 25 lines when you
exit WordStar.

= IBM PC VGA with 50 lines This monitor choice displays 50 lines onscreen
while editing in WordStar and then reverts to the usual 25 lines when you
exit WordStar.

For most types of monitors, you can choose an option that includes onscreen
underlining. Choose one of those options only if your monitor supports
onscreen underlining.

After you make your monitor selection, you can choose screen colors. If you
want WordStar to display in monochrome, choose Use standard monochrome
display if your monitor displays underlined characters or Use alternate mono-
chrome display (includes most laptops) if your monitor does not display under-
lined characters. If you want WordStar to display in the preset colors, choose
Use standard color display. If you want to customize the colors displayed in
WordStar, use WSCHANGE.

SETTING BASIC EDITING DEFAULTS

Use the WINSTALL Set basic editing defaults option if you want to change
some of the basic WordStar editing defaults. The following items are listed on
the menu:

= Help level This option allows you to change the default menu display
level. The default level is 4, pull-down menus.

= Default paragraph style A paragraph style sets the default font, margins,
tabs, line height, line spacing, justification, and print attributes to be used in
your documents. The default paragraph style is Body Text. Use this option
if you want to change the default.
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Initial logged directory With this option, you can change the drive and
directory WordStar logs on to each time you start the program. If you work
in a particular drive and directory most of the time, you can have WordStar
log on to that drive and directory.

Default printer The first printer you install in WordStar is the default printer.
If you have installed more than one printer, you can use this option to change
the default. The default printer should be the printer you use the most.

Enter key in dialog boxes You can use this option to choose the way you
want the Enter key to work in dialog boxes. The Enter key can close the
dialog box (the default) or move from one option to the next.

Check CONFIG.SYS file When you choose this option, WordStar checks
your CONFIG.SYS file to make sure it is correct for your DOS version and
WordStar. It must contain the line FILES=30 (for DOS 3.0 or later) or
FILES=20 (for DOS 2.n or earlier) for WordStar to function properly. If the
FILES= statement is not set to the correct value, WordStar will modify the
file and save your current CONFIG.SYS file as CONFIG.OLD. Remember to
reboot your computer after the CONFIG.SYS file is modified.

Modify AUTOEXEC.BAT file When you choose this option, WordStar
modifies your AUTOEXEC.BAT file to include the WordStar directory name

in the path. Remember to reboot your computer after the AUTOEXEC.BAT
file is modified.

ADDING OR REMOVING A FEATURE

You can use this WINSTALL option at any time to add or remove various
WordStar features, such as Star Exchange, MailList, or TelMerge®.

To add a feature, move the highlighting to the feature to be added and type +
(plus sign). When you finish marking the features you want to add, press F10.
Insert the disk that is requested and press F10.

If you want to change the directory or subdirectory to which a highlighted fea-

ture is copied, press F3. Type a new name and press Enter. WordStar creates
the directory for you.
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If you want to remove a feature, first rename any user-modifiable files used for
that feature or move them to a different directory. For example, before you
remove MailList, be sure to rename or move the .DTA files. WordStar does not
delete your document files, PDFs, or WSCHANGE setting files when you
remove a feature. However, if a directory is empty after a feature has been
removed, WordStar removes the empty directory.

To remove a feature, move the highlighting to the feature to be removed and
type a minus sign (—). When you finish indicating changes, press F10.

When a feature has been added, the plus sign (+) on the screen changes to a
small square (=). When a feature has been removed, no mark appears.

If you copy or delete WordStar features at the DOS prompt instead of using
WINSTALL, the changes are not reflected on the Add or Remove a Feature
screen.

INSTALLING A PRINTER

You probably installed a printer when you installed WordStar. The following
instructions describe how to install a new or additional printer.

When you install a printer, information about that printer is copied to a file
called a printer description file (PDF). When you print a document, WordStar
gets the printer information it needs from the PDF. For example, the PDF tells
WordStar what fonts are available for your printer. Every time you install a
printer, you create another PDF. You can install as many printers as you want,
and you can have multiple PDFs for the same printer. For example, you might
put the fonts you use for proposals in one PDF and the fonts you use for memos
in another.

To install a printer, choose Modify or install a printer (PRCHANGE) from the
WINSTALL Menu (or type prchange at the system prompt and press Enter). At
the Installed Printer Menu, type a name for the PDF and press Enter. Use a
name that describes the printer you're installing, for example, EPSON (don’t
choose an existing PDF name).
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At the Printer Type Menu, choose the type of printer you have (see the table

below).

MENU CHOICE

HP Laserets
and compatibles

Other lasers
PostScript lasers

HP DeskJets
and compatibles

Others A-D
(includes generic)

Others E-N
Others O-R
Others S-Z

Extra database

CHOOSE FOR

HP Laser)et and compatible printers

Other laser printers
Laser printers with PostScript capability

HP DeskJet or Desk]et Plus and
compatible printers

Other printers starting with the letters A-D, and
generic printers (such as CUSTOM and SIMPLE)

Other printers starting with the letters E-N
Other printers starting with the letters O-R
Other printers starting with the letters S-Z

Use this with supplementary disks supplied
by WordStar

Note: If you didn’t install the Printer Data feature when you installed WordStar,
you’re prompted to insert the appropriate disk or type the drive and directory
where the Printer Data is located. Insert the requested disk and type the drive
letter, or type the directory path, and press F10.

The Printer Selection Menu appears. Move the highlighting to the name of
your printer, or type the first letter of the printer name to move through the
list to printers that begin with that letter. Press Enter to install the printer.

Note: If your printer isn't listed on the Printer Selection Menu, see The printer
isn’t on the Printer Selection Menu under “Troubleshooting Printer Problems.”

After installing a printer, you can use the Additional Installation Menu to specify
your printer port, install a sheet feeder, or add or delete fonts. The following
diagram shows the choices on the Additional Installation Menu.
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CREATING A PDF

WINSTALL Main Menu
PRCHANGE Option

l
Installed Printer Menu
[
Printer Type Menu
[
Printer Selection Menu
[

Additional Installation

—
l [ l |

Select printer Install Printer Add or delete
adapter port sheet feeder Information Menu font groups

TIP After you install a printer, go to the Printer Information Menu to view,
print, or save information about the printer you installed. This information may
help you take advantage of your printer’s capabilities.

When you finish installing your printer, choose Return to Installed Printer Menu.
At the prompt Do you want the printer you installed to be your default printer?
type Y or N.

Note: The first printer you install is your default printer. Each time you install
another printer, a prompt asks if you want the new printer to be your default.
The default printer (PDF) is assigned to each document you create and deter-
mines what fonts you can choose when you edit a document. You can assign
a printer other than the default printer to a document when you edit the
document.

At the Installed Printer Menu, press F10 to return to the WINSTALL Menu.
Or, if you want to install another printer, type the name of a new PDF and
press Enter.
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TIP You can print the PRINT.TST file to see how WordStar uses the features
of your printer. For example, if your printer supports color, print the PRINT.TST
file to see how the colors print. If your printer is a PostScript printer, print the
PSPRINT.TST file.

Now that you've installed a printer, you may not need to read any further.
However, if you want more information about any of the items listed below, see
“Customizing Your Printer in PRCHANGE.”

= Adding cartridge fonts

= Adding downloadable soft fonts or making batch files to download soft fonts
m  Creating preview screen fonts

= Choosing internal fonts

= |nstalling sheet feeders or special paper-handling capabilities

= Changing the printer port

®  Using printer features that WordStar doesn’t support

Note: If you have any printing problems, see “Troubleshooting Printer
Problems.”

CUSTOMIZING YOUR PRINTER IN PRCHANGE

2-10

After you choose a printer and create a PDF in WordStar, you can modify (or
customize) that PDF at any time using the PRCHANGE option in WINSTALL.
The following diagram shows the choices you have for modifying a PDF.
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MODIFYING A PDF

WINSTALL Main Menu
PRCHANGE Option

l
Installed Printer Menu
[
PDF Modification Menu
|

l l [ [
Add or Install Change custom |||Create download
delete fonts sheet feeder printer codes batch file
Rename PDF Change printer | | Create preview Change print
adapter port screen fonts time settings
MODIFYING A PDF

To modify a PDF, choose Modify or install a printer (PRCHANGE) from the
WINSTALL Menu, or type prchange at the system prompt and press Enter. At
the Installed Printer Menu, move the highlighting to the PDF you want to
modify and press Enter. (If the PDF is in another directory, type the path and
press Enter. Then choose the PDF.) If you haven't installed the Printer Data,
follow the onscreen instructions to insert the appropriate disk or type the loca-
tion of the Printer Data on your hard disk . When you’re asked if you want to
modify the PDF, type Y. The PDF Modification Menu appears.

The options on the PDF Modification Menu are described below.

Add or delete fonts When you choose this option, WordStar displays a list of
fonts currently in the PDF and asks if you want to change them. You can add
or delete fonts as needed; for example, your printer may have additional
cartridge or soft (downloaded) fonts that you want to add. (The fonts in a PDF
are listed on the screen when you select a font in WordStar.)

When you add fonts, keep these points in mind:
= |f many fonts are available for your printer, add only the fonts and sizes that

you plan to use. Otherwise, the PDF may become too large for you to add
more fonts, and the list of fonts that is displayed in WordStar will be very

2-11
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long. You can always add fonts later, or create another PDF for the same
printer and use different fonts.

The font list displayed when you’re adding cartridge or soft fonts shows all

the font groups that are available for your printer; however, you may not

have purchased or installed all of them. If you add fonts that your printer
doesn’t have, and then try to use them in a document, your printer will use
a substitute font.

When you choose to change fonts, the Add or Delete Fonts menu appears. The
types of fonts listed on the Add or Delete Fonts menu are described below. For
step-by-step instructions on how to add them, see “Adding Fonts to a PDF” in
this section.

Cartridge fonts are contained on cartridges that you insert into slots on your
printer. WordStar supports most cartridges made by printer manufacturers.
If your cartridge is not listed on the Add Cartridges screen, it might work like
one or more of the other cartridges on the list. You can also contact the
manufacturer of the cartridge to see if special PDFs or custom printer
databases have been developed for WordStar.

Internal fonts come preinstalled in the printer. Most printers have only one
internal font group, but some printers, such as the HP DeskJet, have many.
You may want to add only some of them to the PDF.

Soft fonts must be downloaded (copied from a disk) to your printer before
you can use them. The number of fonts you can download depends on the
size of the font files, the amount of memory in your printer, and the number
of soft fonts the printer allows. Use this option only for printers other than
HP Laser]ets, PostScript printers, Xerox 4045, and IBM 4019 and 4029
printers. For these printers, and for other soft fonts that aren't listed on the
Add Soft Fonts screen, you need to create a custom database and then use
the Fonts from custom database option (see “Adding Custom Fonts” in this
section).

Fonts from custom database are cartridge and soft fonts that are not listed
on the Add Cartridge Fonts or Add Soft Fonts screens. You can add fonts to
the custom database for HP Laser)et and compatible printers, PostScript
printers, Xerox 4045 printers, and IBM 4019 and 4029 printers. See
“Adding Custom Fonts” in this section.



CUSTOMIZING YOUR PRINTER IN PRCHANGE

When you finish adding fonts, WordStar asks if you want to change font
families. Within each font family, you can assign different fonts for bold, italic,
bold-italic, superscript, subscript, or graphics. For example, you may want to
assign a smaller font for subscript and superscript (smaller subscripts and super-
scripts are automatic on scalable font printers).

Rename current PDF Choose this option to rename a PDF. For example, if
you have two laser printers, you might want to assign names such as LASER1
and LASER?2 to distinguish one from the other.

Modify sheet feeder You can change the sheet feeder specified in a PDF. (For
many printers, the default sheet feeder or tray is automatically installed and you
can change from one tray to another by choosing Layout=>Page and specifying
the Paper Bin or by using the .bn command.)

Note: Most sheet feeders need special page length and margin settings to work
correctly. If you install a sheet feeder, check the Printer Information screen to
see the sheet feeder requirements for your printer.

Change printer adapter port WordStar assumes your printer is connected to
the LPT1 port at the back of your computer. If your printer is connected to a dif-
ferent port, use this option to identify it. You can also use this option to change
printer protocol or background print speed, or to specify a user-defined device
or disk.

If you change to a serial port (COM1 or COM?2), you need to enter the correct
MODE command at the DOS prompt before printing. For more information,
see “Troubleshooting Printer Problems.”

Change custom printer code You can customize the commands APF, APG,
APQ, APW, APE, and ~PR (or Insert=>Custom Printer Code=>1-6) to perform
special functions on your printer. For example, if your printer has a half-
speed mode, you can customize one of these commands to insert the code

for half speed. Refer to your printer manual for the codes for your printer.
Enter the code in ASCII (see the “ASCII Conversion Charts” in Appendix B of
the Reference manual). You can type up to 73 characters in each code. Then,
when you use the command in a document, WordStar inserts the code. For
more information, see “Custom Printer Code” and “Change Printer Codes” in
“Editing Screen Insert Menu” in the Reference manual. .
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For some printers, the custom printer codes have already been customized to
perform special functions. Check the Printer Information screen for your printer
to see any preprogrammed codes.

You can use custom printer codes to send an ASCII (nondocument) file contain-
ing printer codes to your printer. Choose the custom printer code command to
modify, and then type %F"filename" as the code. Be sure to capitalize the F
and include the quotation marks. The filename should include a drive and
directory if the filename isn’t in the WordStar directory (usually WS). When
you're editing in WordStar, you can add a program file to your document by
choosing Insert=>Custom Printer Code=>Other, or pressing AP!, and then typing
the filename. If you have a laser printer, see “Notes on Laser Printers” in this
section for more information.

Note: You can enter a file with codes for all printers except the special-use
PDFs ASCII, ASC256, PRVIEW, and XTRACT.

Create preview screen fonts Screen fonts are used for Preview and for creating
fax files. They correspond to HP Laser)et or compatible soft fonts, and are used
in Preview only if you are using those fonts in your document. (If you don’t
have soft fonts, you can create fax files using the .WSF files supplied with
WordStar.) WordStar translates most printer fonts to screen (or fax) fonts so

you can see your document onscreen exactly as it will be printed, and so that
you can send faxes using those fonts.

When you choose this option, you are prompted for the location of your font
files. WordStar scans the PDF for unique typefaces, and then looks at the
FONTID.CTL file. At the end of FONTID.CTL is a list of existing screen font
(.WSF) files. A new .WSF file is created for each unique typeface that is not
listed in FONTID.CTL.

Note: Fonts larger than 72 points are displayed as 72-point fonts in Preview.
However, the spacing is correct.

Note: If you are using fonts from a custom database with Preview, make sure
they appear after the 16 standard typefaces on the list of typefaces in the
FONTID.CTL file. Otherwise, the correct font may not be shown in Preview.
Whenever you change the list of fonts in FONTID.CTL, be sure to delete the
line that begins with VER=.
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If you want to create Preview fonts for scalable fonts, use a font generation pro-
gram such as Type Director 2.0 to create one bitmapped (presized) font, in one
size and symbol set, for each font you want to preview. If you’re not sure
which size to create, choose 12-point. If you’re not sure which symbol set to
create, choose USASCII. Then, for each font you want to preview, type
dispfont and the name of the font file, and press Enter. (After you finish creating
preview screen fonts, you can delete the bitmapped font files you created.)

For more information on Preview, see “Fine-tuning Preview” in “Advanced
Customizing.”

Create download batch file You can create a batch file that will download the
soft fonts in a PDF to your printer. Just type a name for the batch file, or choose
an existing batch file, and press Enter. When you choose this option, you are
prompted for the location of your font files.

TIP To download the fonts to your printer, log on to the drive or directory
where the batch file is located and type the name of the batch file. If you get
the message Bad command or filename, make sure the file PECHO.COM is in
the same directory as the batch file. If you share the printer with other users, be
sure no one else is using the printer when you download fonts.

Change print-time settings Use this option to change the default settings for
form feeds and to pause between pages.

Return to Installed Printer Menu Choose this option when you finish modify-
ing a PDF. At the Installed Printer Menu, you can install another printer,
choose another PDF to modify, or press F10 to return to the WINSTALL Menu
or the DOS prompt.

DELETING A PDF

To delete a PDF, use the DOS DEL command to remove the PDF file. Logon to
the directory containing WordStar (usually WS), type del filename.pdf, and
press Enter.



CUSTOMIZING WORDSTAR

ADDING FONTS TO A PDF

The following pages contain step-by-step procedures for adding fonts to a PDF.
If you need help at any time in PRCHANGE, press F1.

ADDING CARTRIDGE FONTS OR INTERNAL FONTS

The following procedure describes how to add any internal fonts and most
cartridge fonts to a PDF. If a cartridge is not listed on the Add Cartridges screen
(in step 6), you may need to treat it the same as a custom font (see “Adding
Custom Fonts”).

1 Atthe WINSTALL Main Menu, choose Modify or install a printer
(PRCHANGE).

2 At the Installed Printer Menu, choose the PDF you want to add fonts to.

3 If you haven't installed the Printer Data, follow the onscreen instructions to
insert the appropriate disk or type the location of the printer data on your
hard disk.

4 When you're asked if you want to modify the PDF, type Y. The PDF
Modification Menu appears.

5 Atthe PDF Modification Menu, choose Add or delete fonts.
6 Atthe Current Fonts in PDF Menu, type Y.

7 Atthe Add or Delete Fonts Menu, choose Add cartridge fonts or
Add internal fonts. Then follow the instructions below for the type of
fonts you’re adding.

Cartridge fonts At the Add Cartridges screen, move the highlighting to
each cartridge you want to add, and press Enter to mark it. When you finish
marking cartridges, press F10 to add them to your PDF.

Note: Some cartridges have choices for different symbol sets. For example,
Roman 8 (R8) cartridges have R8 and R8 IBM Emulation choices. If you
aren’t sure which you want to install, choose R8 IBM Emulation.
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Internal fonts At the Add Internal Font Groups screen, move the highlight-
ing to each font group you want to add, and press Enter to mark it. When
you finish marking font groups, press F10 to add them to your PDF.

When you finish adding fonts, WordStar asks if you want to change font
families. If you want to change font families, type Y and follow the
onscreen prompts. Otherwise, type N.

At the Add or Delete Fonts Menu, choose Return to previous menu. At the
PDF Modification Menu, choose Return to Installed Printer Menu. At the
Installed Printer Menu, press F10 to return to the WINSTALL Menu.

Note: Be sure to insert the correct cartridge in the printer before you print with
this PDF.

ADDING SOFT FONTS

The following procedure describes how to add soft fonts to a PDF for printers
other than HP Laserjets and compatibles, PostScript printers, Xerox 4045, and
IBM 4019 and 4029 printers. To add soft fonts for these printers, or fonts that
are not listed on the Add Soft Fonts screen (in step 7 below), you must use a cus-
tom font database (see “Adding Custom Fonts”).

1

At the WINSTALL Main Menu, choose Modify or install a printer
(PRCHANGE).

At the Installed Printer Menu, choose the PDF you want to add fonts to.
If you haven't installed the Printer Data, follow the onscreen instructions to
insert the appropriate disk or type the location of the printer data on your

hard disk.

When you’re asked if you want to modify the PDF, type Y. The PDF
Modification Menu appears.

At the PDF Modification Menu, choose Add or delete fonts.
At the Current Fonts in PDF Menu, type Y.

At the Add or Delete Fonts Menu, choose Add soft fonts.
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8 Atthe Add Soft Fonts Menu, move the highlighting to each font group you
want to add, and press Enter to mark it. When you finish marking font
groups, press F10 to add the marked font groups to your PDF.

Note: Some soft fonts have choices for different symbol sets. For example,
Roman 8 (R8) soft fonts have R8 and R8 IBM Emulation choices. If you
aren’t sure which one you want, choose R8 IBM Emulation.

9 Atthe Available Typefaces Menu, move the highlighting to each typeface
you want to add, press Enter to mark each one, and press F10 to add the
marked typefaces to your PDF.

10  Atthe Available Type Sizes Menu, move the highlighting to each type size
you want to add, press Enter to mark each one, and press F10 to add the
marked type sizes to your PDF.

17 When you finish adding fonts, WordStar asks if you want to change font
families. If you want to change font families, type Y and follow the
onscreen prompts. Otherwise, type N.

12 Atthe Add or Delete Fonts Menu, choose Return to previous menu. You're
asked if you want to create screen fonts. If you don’t create screen fonts,
WordStar uses the default Times Roman and Helvetica screen fonts in
Preview. Type Y and follow the prompts to create screen fonts for Preview,
or type N to return to the PDF Modification Menu.

13 At the PDF Modification Menu, choose Return to Installed Printer Menu.
At the Installed Printer Menu, press F10 to return to the WINSTALL Menu.

Note: Be sure to download the correct fonts to the printer before you print with
this PDF. You can create a downloading batch file in PRCHANGE, or you can
use a downloading program supplied with your fonts.

ADDING CUSTOM FONTS

Custom fonts include soft fonts for PostScript, HP LaserJet and compatibles,
Xerox 4045, and IBM 4019 and 4029 printers, and cartridge fonts not listed on
the Add Cartridge Fonts screen. The steps below show what you need to do to
use custom fonts with WordStar and where to find information for each step.
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Create the fonts (if you use a font generator program like Type Director), or
have the required files on your disk. The types of files you may need are
described after these steps. For more information, see the documentation
for your fonts.

Use the LSRFONTS option in WINSTALL to add the fonts to the custom font
database. For more information, read the rest of this section. (The custom
font data is stored in .DTU files. If you already have .DTU files from Word-
Star 6.0, you don’t need to create new ones. However, if you have earlier
.DTU files, you'll have to create new ones.)

Use the PRCHANGE option to add the fonts from the database to a PDF.
For more information, read the rest of this section.

Download the fonts to the printer or insert the cartridge into the printer. For
more information, see the vendor documentation for your fonts.

In WordStar, attach the correct PDF to the document. For more information,
see “Change Printer” in “Editing Screen File Menu” in the Reference manual.

Choose the fonts you want to use in the appropriate locations in the docu-
ment. For more information, see “Font” in “Editing Screen Style Menu” in
the Reference manual.

When you add fonts to the custom database, you may be prompted for the loca-
tion of your font files, .AFM files, or AutoFont support files.

Font files are either on purchased floppy disks or created by a font generator
program.

AFM files are included with PostScript fonts. (PostScript internal fonts are
included in a PostScript PDF when it is created.)

AutoFont support files for scalable soft fonts can be created when you create
the fonts. In Type Director, choose Environment. Then choose or create an
AutoFont Support application. Choose Utilities, and then choose
Application Utility. Under Active Application, choose AutoFont Support.
To create the AutoFont support files, press F1.
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ADDING FONTS TO THE CUSTOM FONT DATABASE Follow the steps below to
add fonts for a laser printer, including HP Laserjet or compatibles, PostScript
printers, IBM 4019 and 4029, and Xerox 4045. If you need help at any time in
LSRFONTS, press F1.

7 At the WINSTALL Main Menu, choose Add fonts to custom database
(LSRFONTS), or type Isrfonts at the DOS prompt and press Enter.

Note: If the monitor display isn’t clear, exit the program, type Isrfonts /m at
the DOS prompt, and press Enter. The program will use a monochrome dis-

play.

2 Atthe Add Fonts to Custom Database menu, choose the type of fonts you
want to add.

3 Type the name of the drive or directory where your font files, .AFM files,
TFM files, or .MTR files are located and press the F10 key.

4 Atthe Available Fonts Menu, move the highlighting and press Enter to mark
each font you want to use. Press F2 if you want to change the menu name
of the highlighted font. (The menu name is the name that appears when you
select a font in WordStar.)

Note: To see fonts in a different directory, press F8. Then type + and the
directory name.

5 Press F10 to add the marked fonts to the database.

If you're creating a custom font database for the first time, or if your
database is not in the current directory or on the DOS path, you are
prompted for the location of the custom font database. Type the drive and
directory location of the database, and press Enter.

Note: If .DTU files are on the DOS path, the font information you just
entered is stored in the .DTU file that comes first on the path. If you have
old .DTU files from a release of WordStar previous to 6.0, be sure you don’t
add the font information to those .DTU files; the resulting file may be un-
usable in either version.
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If you have an HP LaserJet Il or compatible printer with cartridge fonts,
you're prompted to choose a symbol set as each font is added to the
database. Press Enter to mark the symbol sets you want, and press F10 to
add the marked symbol sets. If you're not sure which symbol set to use,
choose PC: PC-8.

At the message Do you want to remap the symbol set? choose No to access
the symbol set on your printer even when it doesn’t match the screen sym-
bol set. If you choose Yes, the printed characters will emulate the screen
characters as closely as possible.

6 At the prompt to name the font group you just created, press Enter to use
the current system date and time as the font group name, or type a more
descriptive name (for example, Tms Rmn 10-18 or Tms & Helv), and
press Enter.

7 Atthe Add Custom Laser Fonts to Database Menu, choose Return to
WINSTALL Menu to quit, or repeat steps 2 through 6 to add more font
groups.

Now you’ve added font information to the custom database. Next you'll use
PRCHANGE to copy to your PDF the font information from the database you
just created. The fonts will appear on the font list when you select a font in
WordStar.

ADDING CUSTOM DATABASE FONTS TO A PDF  Follow the steps below to
add the custom database fonts to a PDF.

T At the WINSTALL Menu, choose Modify or install a printer (PRCHANGE).

2 Atthe Installed Printer Menu, choose the PDF you want to add fonts to.

3 If you haven't installed the Printer Data, follow the onscreen instructions to
insert the appropriate disk or type the location of the printer data on your

hard disk.

4 When you're asked if you want to modify the PDF, type Y. The PDF
Maodification Menu appears.

5  Atthe PDF Modification Menu, choose Add or delete fonts.
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10

11

12

13

At the Current Fonts in PDF Menu, type Y.
At the Add or Delete Fonts Menu, choose Add fonts from custom database.

If your custom font database is not in the current directory or on the DOS
path, you're prompted for its location.

At the Add Soft or Custom Fonts Menu, move the highlighting and
press Enter to mark each font group you want to add, or press F4 to mark all
the font groups listed. When you finish marking font groups, press F10.

At the Available Typefaces Menu, move the highlighting and press Enter to
mark each typeface you want to add, or press F4 to mark all the typefaces
listed. When you finish marking typefaces, press F10.

At the Available Type Sizes Menu, move the highlighting and press Enter to
mark each type size you want to add, or press F4 to mark all the type sizes
listed. If you are adding scalable fonts, you don’t need to choose sizes; just
choose the font. When you finish marking type sizes, press F10 to add the
marked fonts to your PDF.

When you finish adding fonts, WordStar asks if you want to change font
families. If you want to change font families, type Y and follow the
onscreen prompts. Otherwise, type N.

At the Add or Delete Fonts Menu, choose Return to previous menu. At the
PDF Modification Menu, choose Return to Installed Printer Menu.

At the Installed Printer Menu, press F10. At the WINSTALL Menu, choose
Save and return to DOS.

Note: Be sure to download the correct fonts to the printer before printing with
this PDF. You can create a download batch file in PRCHANGE, or you can use
a downloading program supplied with your fonts or purchased separately.



NOTES ON LASER PRINTERS

INOTES ON LASER PRINTERS

To install a laser printer, choose the appropriate type of printer from the Printer
Type Menu. Then choose your printer from the Printer Selection Menu. For
more information, see “Installing a Printer.” For information on adding fonts for
the printer, see “Adding Fonts to a PDF” in this chapter. If you have any
problems with your printer, see “Troubleshooting Printer Problems.”

SETTING MARGINS

Most laser printers can’t print in areas close to the edges of the page, so if you
change margins in a document, always leave at least .5 inch of blank space in
the top and bottom margins in addition to the space needed for a header or
footer.

USING PRINTER-LANGUAGE PROGRAM FILES

You can create program files in your printer’s language for special printer fea-
tures or for printing special graphics, such as page borders or a company logo.
For example, you can create PostScript files for a PostScript printer, or PCL files
for a LaserJet or compatible printer. When you use a printer program file with a
WordStar document, the printer codes in the file are sent to the printer, and the
text or graphics are added to your page. You can modify the program files by
editing them in nondocument mode.

To insert a program file into a WordStar document, choose Insert=>Custom
Printer Code=>Other, or press AP!. In the Custom Printer Code dialog box,
type % F"filename"—be sure to capitalize the F and include the quotation
marks. (The filename is the name of the program file; it can include a drive and
directory.) For the characters to display onscreen, type a descriptive name that
will help you remember what the file does, for example, squarebullet.

TIP You can put the name in angle brackets so it looks like a command tag
on the screen rather than regular text, for example, <squarebullet>.
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If you want to program the custom printer commands to access your own pro-
gram files, see Change custom printer codes under “Modifying a PDF” in this
section. You can then use Insert=>Custom Printer Code and the appropriate
number (or APF, APG, APQ, A"PW, APE, or ~PR) to insert the code whenever
you want to use it.

OVERPRINTING A PAGE

Occasionally you may want to print two pages of text or graphics superimposed
on each other. For example, if you have a border that you want to place
around the page of text, it may be easier to treat the border and text as separate
pages while you're editing them.

On many laser printers, including HP LaserJets and compatibles and PostScript
printers, you can overprint two or more pages using the .xl 00 (two zeros)
command.

Normally, WordStar sends a form feed at the end of each page. The .xl com-
mand sets the form feed command sent to the printer, and the setting of 00
sends nothing. Type .xI 00 on a line by itself on the first page you want to
overprint. Since no form feeds are sent to the printer, subsequent pages are
overprinted. To stop overprinting, type .xI 0C on a line by itself on the first
page you don’t want overprinted.

Don't use any .bn commands (or change the Paper Bin setting in Layout=>Page)
in the same document as the .xl 00 command. The .bn command issues its
own form feeds, so the .xI 00 can’t take effect.

If you have trouble overprinting pages, and the .xl 00 command is at the top of
a page, move it lower on the page (below some text).

HP LASERJET AND COMPATIBLE PRINTERS

USING THE SAMPLE HP PROGRAM FILES

You can create your own printer program files for printing special graphics. See
“Using Printer-Language Program Files” in this section. You can also use the
four sample HP program files that are included with WordStar.
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SAMPLE PROGRAM FILE DESCRIPTION

CHEX.HP Prints a checkerboard at the top of the page
PLEAD.HP Prints legal pleading lines without the numbers
SHADE.HP Prints a 15 percent gray background on the page
ARROW.HP Prints an arrow at the cursor position

USING CODE PAGES

Code pages are onscreen character sets. WordStar supports code pages 437
(United States) and 850 (Multilingual). The characters in code page 437 and
code page 850 are listed in the Reference manual in Appendix B, “ASCII
Conversion Charts.”

You can use DOS (versions 3.3 and later) to set a code page to change the char-
acters that are displayed onscreen (for more information, see your DOS
manual). You can change the default code page for WordStar in WSCHANGE
(DCGL). When you set WordStar to use code page 850, WordStar recognizes
the code page 850 characters in sorting, case conversion, spelling checks, and
cursor movement, and displays those characters in Preview.

You can use code page 850 with HP Laserjet and compatible printers and
with IBM printers. For a LaserJet or compatible printer, use fonts with the
appropriate symbol set, or create soft fonts with the appropriate symbol set
using a font generation program. For LaserJet Ill or compatible cartridge fonts,
use LSRFONTS to read the AutoFont support files that come with the cartridge.
For an IBM printer, use the instructions in your DOS manual for setting up a
printer for code page 850.

If you want to see the code page 850 characters in Preview, see “Fine-tuning
Preview” in “Advanced Customizing.”

POSTSCRIPT PRINTERS

WordStar comes with several files with the .PS filename extension for use
with PostScript printers. Make sure these files are in your WordStar directory.
If you didn’t add them when you installed WordStar, you can use the

Add or remove a feature option in WINSTALL to copy the files to your

hard disk.
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For printers that are connected to a serial port, WordStar works with either DTR
or XON/XOFF protocol (the default is DTR). If your printer uses XON/XOFF
protocol, use PRCHANGE and choose Change printer adapter port, and then
Printer protocol selection to change it. If you have any problems, see The
printer isn’t printing under “Troubleshooting Printer Problems.”

To use legal-size paper, edit the WSPROL.PS file in nondocument mode, and
change the value for the /pgsize variable from 11 inches to 14 inches. To print
in landscape mode, select Landscape in the Layout=>Page (or AOY) dialog box
during editing.

The Postscript Generic (PS:2Up) choice on the Printer Selection Menu is good
for printing small booklets or program listings. Using landscape mode, it prints
two side-by-side pages on each sheet of paper. The fonts on the page are
reduced to 65 percent of their usual size. You can use a PostScript 2Up PDF
only with 8.5 x 11-inch (letter-size) paper.

USING THE SAMPLE POSTSCRIPT PROGRAM FILES

You can print the PSPRINT.TST file to see how you can use many PostScript
features with WordStar.

You can also create your own PostScript program files for printing special
graphics. See “Using Printer-Language Program Files" in this section. You can
also use the four sample PostScript program files that come with WordStar. The
following list shows the sample PostScript program files and the custom printer
commands you use to add them to a document.

SAMPLE PRINT

PROGRAM FILE COMMAND DESCRIPTION

LETTER.PS APQ Prints an easily-modified sample
letterhead

BORDER.PS APW : Prints a border around the current page

LOGO.PS APE Prints a sample logo

BOX.PS APR Prints a double box with its upper-left

corner at the cursor position
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EDITING THE BOX.PS FILE To change the size of the box in the BOX.PS file,
choose Insert=>Custom Printer Code=>Other (or use AP!) to insert the file into
your document. When WordStar prompts you for the characters to send to the
printer, type the variables you want to change (see the table below) and then
type %F"box.ps"—be sure to capitalize the F and include the quotation marks.
For example, to get a box 2 inches wide by 3 inches high, type this:

/bw 2 inch def /bh 3 inch def %F'box.ps"

If you don’t want the nested box, set /bg to 0 (zero). Be sure to type the settings
correctly; mistakes may cause printing errors.

VARIABLE MEANING DEFAULT VALUE
/bw ninch def box width 4 inches

/bh ninch def box height 4 inches

/bt n def box-edge thickness 1.5 points

/bg n def gap between nested boxes 3 points

CREATING YOUR OWN POSTSCRIPT PROGRAM FILES

If you create your own PostScript program files, include a “save” command at
the beginning of each file and a “restore” command at the end to preserve the
original state of the printer after the commands have been executed. (To see a
sample, look at the PostScript program files that come with WordStar.) If you
use a “showpage” command in a PostScript file, WordStar breaks the page at
that command at print time.

TRO UBLESHOOTING PRINTING PROBLEMS

This section offers solutions to the most common printer problems.
The printer isn’t printing.

= Make sure the printer is plugged in, turned on, and has paper. If your
printer has an online or select switch, make sure it’s set for online. If the
printer is on a network, you may need to link to it before you can use it.
Check with your system administrator for details.
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If you have a serial printer, make sure the correct mode statement is in
your AUTOEXEC.BAT file. The mode statement should look like this:
mode com1:9600,n,8,1,p. If necessary, replace “com1” with the correct
port number for your system, and replace “9600” with the baud rate your
printer is set for. (See your printer manual for more information.)

Make sure you specified the correct printer port when you installed your
printer for WordStar. Printers are connected by cables to ports at the back
of the computer. You need to tell WordStar which port your printer is
connected to (the default is LPT1). Use PRCHANGE to make sure you
specified the correct port.

If your printer has an auto-switch program to switch between emulations
such as PostScript and HP, and that program requires that one emulation is
addressed as LPT1 and the other as LPT2, be sure the correct port is
specified in the PDF.

If you specified the correct printer port, check the cable between the
computer and the printer. If the cable isn’t firmly connected, or if it isn’t
working properly, your printer can't print.

Follow these steps to test the cable and connections:
1 Make sure your printer is set for nonproportional printing.

2 Log on to the drive or directory where the DOS DEBUG program is
located (usually your DOS directory). At the prompt, type debug and
press Enter. The DEBUG prompt (a dash) appears onscreen.

3 Press AP to establish a connection between the screen and the printer.
After you press AP, everything on the screen is sent to the printer.

4 At the DEBUG prompt, type D100 1000 and press Enter. If the printer is
connected properly, it begins printing. The printer cannot print as fast as
the characters appear onscreen, so after a short time, the screen will stop
filling while the printer catches up. If you want to stop the debug
display, press AC.

5 To stop your printer, press AP again. Then type Q and press Enter to exit
DEBUG. Turn your printer off and then on again to clear the buffer. (If
you have a page printer, be sure to do a form feed before you turn off the
printer so that the last page is printed.)
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Look at the printer output. The DEBUG output should appear in columns
of numbers and letters. If the columns are misaligned (indicating missing
letters) or incomplete, your printer is not working properly. Contact your
printer dealer for help.

= [f the output is printed correctly, but the printer still won’t print with
WordStar, the problem may be in the way that WordStar sends information
to the printer. Start WordStar and press P to print a document. In the
Print dialog box, type the name of the document. In the Redirect To box,
type the name of the port your printer is connected to; for example, Ipt1 or
com1 (do not type a colon after the name of the port). If the document
prints, use PRCHANGE to specify that port as a user-defined device.

= |f the printer still doesn’t print, use WSCHANGE to turn off the printer busy
test (on the Printer Busy Handshaking Menu), or use PRCHANGE and
choose PRN as the default port for the printer.

TI1P Ifyou use either of the above methods, and editing slows down
when you print in the background, use PRCHANGE to set the background
print speed to the speed of your printer. See The printer prints fine for a
while, then output becomes garbled in this section.

= |f you have a PostScript printer, be sure that WordStar and the printer are
using the same protocol. To change the protocol, use PRCHANGE, and
choose Change printer adapter port, and then Printer protocol selection. If
you are using DTR but previously changed from another protocol, copy
SETDTR.PS to the correct port for your printer. For example, if your printer
is connected to COM1, type copy setdtr.ps com1.

The printer isn’t listed on the Printer Selection Menu.

Check your printer manual to see if it works like another printer. Many laser
printers work like the HP LaserJet, many daisy wheel printers work like the
Diablo 630, and many dot matrix printers work like the Epson FX-80 or the
IBM PC Graphics printer. If your printer works like another printer, choose that
printer from the menu. If your printer doesn’t work like another printer, choose
Typewriter (if your printer can backspace) or Draft (if it cant). These are
generic printers that work fairly well with almost any printer. The DRAFT PDF
has been created for you, so you don’t need to install that printer. To install
Typewriter, choose Others A-G (includes generic) at the Printer Type Menu.
Then choose Typewr at the Printer Selection Menu.
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Printed output is garbled.

If your output is garbled, you may have the wrong printer assigned to the docu-
ment, or the cable between your printer and computer may be bad. To see
which printer is assigned to the document, open the document and choose the
command to change printers (File=>Change Printers, or AP?). If the wrong
printer is assigned, choose the correct one. If you have more than one printer,
make sure you specified the correct port for each one. For information on
checking the printer port and testing the cable and connections, see

The printer isn’t printing in this section.

The printer prints fine for a while, then output becomes garbled.

This problem usually occurs because your printer can’t accept information as
fast as WordStar sends it. Use PRCHANGE to set the background print speed
to the speed of your printer. For a daisy wheel printer, set the speed to 20; for
any other type of printer, set the speed to 100. To change print speed in
PRCHANGE, choose Change printer adapter port at the PDF Modification Menu,
choose Printer protocol selection at the Change Printer Adapter Port Menu, and
choose Background print speed in CPS at the Printer Protocol Selection Menu.
Alternately, if your printer is connected to a parallel port, you can try typing
mode Ipt1,,p at the DOS prompt before starting WordStar. This command sets
the printer into infinite retry state.

WordStar displays the message Print Wait.

This message does not indicate a problem. It lets you know that printing has
paused for some reason, for example, you may have added a pause printing
command to the file, or your printer may be out of paper. Display the Printing
screen to see why the printer paused. Follow the onscreen instructions to start
or abandon printing, as you prefer.

WordStar displays the message Printer may not be ready.

Be sure the printer is turned on, has paper, and is online. If the printer is ready,
you may have specified the wrong port when you installed the printer. Printers
are connected by cables to ports at the back of your computer. A computer has
more than one port, so you need to tell WordStar which port your printer is
connected to (the default is LPT1). Use PRCHANGE to see if you specified the
correct port for the printer.
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WordStar displays the message You've selected too many fonts. Please start
again and select fewer fonts.

Return to the Installed Printer Menu, choose the PDF again, and add fewer
fonts. The number of fonts you can add is limited by memory and disk space
on the computer and the size of the fonts you're trying to add. You may need
to make more than one PDF for different groups of fonts.

The wrong fonts appear in the printed document.

When editing, you choose fonts from a list of fonts available for the printer
assigned to your document. If you print the document on a printer other than
the one assigned to your document, WordStar chooses the closest available font
on that printer. If you print the document on the assigned printer, and you
don’t get the fonts you specified, check the items below.

= |f your printer uses downloaded fonts, remember to download the fonts
each time the printer is turned off and then on again.

= |f you are trying to use downloadable fonts, make sure your printer has
enough memory for the fonts you download.

= |f you specified the downloaded fonts as temporary, and then reset the
printer, the fonts have been cleared from your printer’'s memory. Download
the fonts again as permanent fonts.

= Make sure you didn’t use a dot command in your document to turn letter
quality or proportional spacing on or off.

=  The memory limitations of your printer may affect the number of fonts that
can be printed on one page.

= |f you're working on a network, another user may have downloaded fonts,
overwriting yours. To avoid this problem, network users should devise a
system for downloading and clearing fonts.

=  The network may not be able to download all the fonts you specified. Some
networks have a “hold” command that waits until you unlink from the
printer before downloading fonts.
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Text creeps up or down on successive pages.

WordStar uses form feeds to advance the paper. If your printer can’t accept a
form feed command, clear the Use Form Feeds check box in the Print dialog
box. You can change the default for this option in PRCHANGE. [f changing
the setting doesn’t work, change the form feed switch on your printer—if the
switch is off, turn it on; if it's on, turn it off. Laser printers and other printers
with sheet feeders must use form feeds to advance the paper and may need
special page length and margin settings. If you use nonstandard paper, such as
labels, form feeds must be turned off.

TIP Before printing a document that is longer than one page, be sure the
paper is properly positioned and ready to print on line 1. On some printers,
you need to set the top-of-form switch from the front panel. You may need to
turn the printer off and on again to clear the buffer. Do not rotate the printer
platen to adjust the top of the form. Check your printer manual for more
information.

On an HP Laserjet printer, the spacing of the letters is wrong.

= |f the spacing is only slightly off, you may not be getting the correct font. If
you have a soft font with the same name as the internal or cartridge font you
want, the soft font choices override the internal or cartridge font choices.
Poor spacing can result. To use the internal or cartridge version of the font,
delete the soft font from the printer's memory.

® You may have used the same font with more than one symbol set in the
PDF. See Internal fonts under “Adding Cartridge Fonts or Internal Fonts” in
this chapter.

® You may not have reformatted your document after changing printers or
fonts.

= If you have an extreme spacing problem where some letters are printed on
top of each other and others are spread out across the page, you may have
chosen a font your printer doesn’t have, and your printer may have chosen a
font with different spacing.

When a Laserjet looks for a matching font, it also tries to match the symbol
set. For example, if you request a Times Roman 10 font with the ROMANS
symbol set, the printer won’t use a Times Roman 10 font with the USASCII
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symbol set. Instead, it tries to find a font, such as the Line Printer font, that
has the ROMANS8 symbol set. (See your printer manual for more
information.)

On a PostScript printer, you get a time-out error if you begin printing on
page 30 or above.

Change the amount of time your printer waits before it sends the error message.
Edit the WSPROL.PS file and add this line toward the beginning of the file:
statusdict /waittimeout 600 put. This sets the wait time-out to 600 seconds
(the maximum setting). The default setting is 30 seconds. To turn off the wait
time-out, set it to zero.

TIP To print error messages when problems occur, copy the file
EHANDLER.PS to your printer; for example, if your printer is connected to
COM1, type copy ehandler.ps com1.

M ANAGING YOUR COMPUTER’S MEMORY

UsING EMS

If you have expanded memory (EMS), WordStar can use it to run faster and
provide more functionality. For example, if you have two windows open, you
have enough memory to start Inset only if WordStar is using EMS. WordStar
detects EMS and uses it as needed.

You can use WSCHANGE (CC2G) to change the amount of EMS WordStar uses.
The default is 16 pages of 16K each. If you have more EMS that you don’t plan
to use while running WordStar, you can try increasing this amount to make
WordStar run faster.

INCREASING AVAILABLE MEMORY

If your computer doesn’t have enough memory for you to use all of the
WordStar features, and you want WordStar to use the minimum amount of
memory, try applying the WSMIN.PAT file as described below.
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Log on to the WordStar directory (usually WS), type wschange ws, and
press Enter.

Choose E (Patching) and then A (Auto-patcher).
Type wsmin.pat and press Enter.

When you see the message “Patching complete,” press any key to return to
the Patching Menu. Then press AX and Y to exit from WSCHANGE.

If this procedure doesn’t free up enough memory for the features you want to
use, try one or more of the following suggestions:

Turn off background printing in WSCHANGE (BDCA).

If you don’t need automatic hyphenation, turn the hyphenator memory off
in WSCHANGE (CCB). This saves about 60K of RAM.

Run the Inset SETUP program, choose Q (Version), and choose Small.
Press F10 to save your changes. This saves about 15K of RAM when you use
Inset. If you want to edit graphics, load Inset from DOS by typing inset/f.

CHANGING WORDSTAR SETTINGS IN WSCHANGE

You can customize the way WordStar works by using the WSCHANGE option
in WINSTALL. You can customize dozens of WordStar settings—from margins
to the colors on your screen—so that the program always looks and acts the
way you want it to. Although you can change many settings for a particular
document while you're editing in WordStar, using WSCHANGE to change the
settings affects all the documents you create. The settings you choose remain in
effect until you change them in WSCHANGE or in the default paragraph style
(see “Manage Paragraph Styles” in “Editing Screen Style Menu” in the Reference
manual).

To use WSCHANGE, choose Customize WordStar (WSCHANGE) at the
WINSTALL Menu, or type wschange ws at the system prompt, and press Enter.
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Note: If you just type wschange and press Enter, the copyright screen appears.
You’re prompted for the .EXE file to change and the .EXE file to save changes to.
If you haven’t changed the name of your WS.EXE file, type ws and press Enter at
both prompts.

The WSCHANGE Main Menu appears.

WSCHANGE MENU STRUCTURE

As you can see by looking at the WSCHANGE Main Menu, WSCHANGE is
organized in categories to help you find the settings you want to change. To
change a setting, you go through a series of menus until you reach the one that
has the item you want to change. You press the letter for that item and type the
new setting.

WSCHANGE has extensive online help that explains most menu choices. If
you have questions about a menu selection, press F1 for help.

The menu structure of WSCHANGE is shown below.

WSCHANGE
Main Menu
[ l [ ]
Console Printer Computer WordStar Patching
| ; | | Default || Disk | | Page | Auto-
Monitor Printer Drives Layout Patcher
Video || Printer | | Operating | || Editing || Save
Attributes Name System Settings Settings
; | | Printing || Memory Other L|{ ResetAll
I!\)Aa(:g}l]tgsr Defaults Usage | Features Settings
L| Printer | | WordStar
T Ks;tc’?,zrsd Interface Files
| | Directory
Display
L| Computer
Patches
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GETTING AROUND IN WSCHANGE

The chart on the following pages shows the path from the WSCHANGE Main
Menu to most items in WSCHANGE.

Using the chart is the easiest way to find an item in WSCHANGE. For example,
if you want to change the top margin setting, first find “Top margin” on the
chart. Then, beginning at the WSCHANGE Main Menu, press the letters shown
(DAAB) for the path. Type the new setting and press Enter. Follow the
onscreen instructions to save the change.

TIP Press X at any menu to save your changes and leave WSCHANGE, or
you can press AC to leave WSCHANGE without saving any changes.

In the chart below, some entries in the SETTING column are followed by one or
more numbers. These numbers refer to notes that appear at the end of this sec-
tion. In the DEFAULT column, the comment “N/A” means there is no default
for the item. The comment “See screen display” means the default is an
onscreen character that can’t be reproduced for this chart, or that the default is
too long for the chart.

SETTING PATH DEFAULT
Alignment ! DBC N/A

Alternate font 2 BCH No font name
Auto backspace characters DBBF None
Auto-align DBCE ON
Auto-backup 3 DCGI 0
Auto-hyphenation DBCC ON
Auto-patcher EA N/A
Automatic leading, 120% of text size BCL OFF
Automatically fill out last record DBHG ON
Background printing (concurrent) BDCA ON

Backup file type CD5D BAK

Backup files when saving CD6D ON

Beep if printer wait condition BDCB ON
Beginning block marker DBDC <B>
Bidirectional printing BCB ON

Binding space character DBA3C (See screen display)
Blank lines suppression DAAK OFF

Blocks DBD N/A

Bottom margin DAAC 1.33"



CHANGING WORDSTAR SETTINGS IN WSCHANGE

SETTING

Buffer size for various features
Busy test for output to printer

“Can’t find that file” prompt

Character conversion patches

Character for line numbering, left margin
Character for line numbering, right margin
Character width 1

Characters before auto-hyphenation
Characters, international table
Characters, maximum unerased

Check for double word

Classic commands at Opening pull-downs
Classic commands displayed on pull-downs
Code page default

Color display alternate palette !

Color display alternate palette 2

Color display default

Colors, save color settings in file

Colors, select individually

Column break character

Column character, snaking

Column mode

Column replace mode

Command tags display

Computer patches

Concurrent printing

Continuous underlining

Copy auto-patch settings

Cursor movement delay

Cursor movement style, vertical

Cursor movement, hardware

Cursor sizes for all other monitors
Cursor sizes for monochrome monitors
Cursor stays in column 1 at marker
Cursor wrap on pull-down menus

Data item separator

Date format for &@& variable
Date format for insert today’s date
Decimal point

Decimal tab stops 4

Default printer 2

Default search path 1 >

PATH

CC
BDAA

DBA2J
DCF
DBJE
DBJG
BCG
DBCD
DCGM
DBEA
DCA)
DBH2A
DBAK
DCGL
ABC
ABD
ABB
ACD
ABA
DBA4D
DBA3D
DBDA
DBDB
DBAB
CF
BDCA
BCE

EA
ACBA
DBH2C
CBCE
ACF
ACE
DBHD
DBA2F

DCEA
DCEC
DCDG
DBFK
DACB
BA
CDAA

DEFAULT

N/A
ON

ON

N/A

(See screen display)
(See screen display)
No font name

5

OFF

500

ON

ON

ON

437

N/A

N/A

N/A

N/A

(See screen display)
C

(See screen display)
OFF

OFF

ON

N/A

ON

OFF

N/A

N/A

0

ON

N/A

N/A

ON

ON

31, 4 (month day, year)
31, 4 (month day, year)

None
Current default
\WS
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SETTING

Default search path 2 2

Default search path 3 >

Default search path 4 °

Default search path 5 °

Default search path 6 >

Default search path 7 2

Default search path 8 °

Default search path 9 ®

Default search path 10>

Default search path 11 2

Default search path 12>

Default search path 13 >

Default search path 14 2

Default search path 15 °

Default search path 16 >

Definitions during spelling session

Del erases left (not at cursor)

Delay disk access if typing

Delay value for auto align

Delay, longest (sign-on)

Delay, medium (menus)

Delay, short (document align)

Dialog boxes, Enter moves from field to field
Dialog boxes, update field from list
Dictionary (main) name/location 56
Dictionary usage

Directory display ’

Directory, display file size

Directory, display files at filename prompts
Directory, display in alphabetical order
Directory, file types excluded from
Directory, filenames that are displayed
Directory, initial log-on

Directory, show files with changing drive/dir.
Directory, show path with filename
Disk access pause

Disk drives, valid

Disk space, display remaining
Dispatch table

Document mode, status line filler character
Dollar format for inserted numbers

Dot command at start of page

Dot command character

Dot command display

PATH

CDAB
CDAC
CDAD
CDAE
CDAF
CDAG
CDAH
CDAI
CDA2A
CDA2B
CDA2C
CDA2D
CDAZ2E
CDA2F
CDA2G
CCC
DBHC
CAB
DBCF
DCGB
DCGC
DCGD
DBH2D
DBH2
DCAB
DCAE
CEA
CEG
CEl
CEB
CEC
CED
CEE
CEH
DBA2E
DBBE
CAA
CEF
CDE
DBA2C
DCDI
DBA4G
DBA4F
DBAE

DEFAULT

\WS

\WS
\WS\INSET
\WS\OPTIONS
\WS\OPTIONS
\WS\INSET
\WS

\WS\FAX
\WS\CONVERT
\WS\MACROS
\WS

\WS

\WS

\WS

\WS

OFF

OFF

0

500

2000

1000

200

OFF

See screen display
SPLMNO00.DCT (U/2)
N/A

ON

ON

ON

ON

(See screen display)
22202202

None

OFF

ON

0

(All drives valid)

ON
WSDSPCH.OVR(U/1)
" (blank)

T pu—p— |1 ]

1

ON
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SETTING

Dot commands automatically put into file
Dot leader character

Edit screen, help level

Editing screen, return to old

Editor, memory allocated for

EMS, amount used

End of line character

End of file character 8

Ending block marker

Endnote buffer size

Endnote file type

Endnote font 2

Endnote reference mark in note, attributes
Endnote reference mark in note, lead char.
Endnote reference mark in note, trail char.
Endnote reference mark in text, attributes
Endnote reference mark in text, lead char.
Endnote reference mark in text, trail char.
Endnote repeating character table
Endnote tag type

Endnote VMI between notes

Endnote VMI for each endnote line
Endnote, default color to use

Endnote, default ruler to use

Enter moves from field to field in dialog box
Erasing and cursor type ahead

Esc acts like AR and J

Exceptions dictionary file

Exit WSCHANGE and save changes

Exit WSCHANGE without saving changes

Fast typing display pause

Fast typing page/line/column delay
Fax file name and path

File directory display

File sizes, display

Filenames

Find and replace default options
Flag column display

Font menu definitions, number of
Font family member definitions, number of
Font size unit of measure

Font, alternate 2

PATH

DBH2B
DBA3F

DBAA
DBH2F
Cd)
cC2G
DBA4K
DBA3)
DBDD
DAD2H
DAD2G
DAD2AA
DAD2DA
DAD2DB
DAD2DC
DAD2CA
DAD2CB
DAD2CC
DAD2B
DAD2E
DAD2FA
DAD2FB
DAD2AC
DAD2AB
DBH2D
DBED
DBHF
CD4D
AXY

AC

DBBC
DBBD
CD4l
CEA
CEG
CcD
DBGA
DBAC
ccac
cca2D
DAGD
BCH

DEFAULT
ON

4
OFF

64K

16 pages

@

A

<K>

2 records

$ES

No font name
0

(

)

32

@

@

#@

3

240

240

0

0

OFF

OFF

OFF
EXCEPT.DCT(U/2)
N/A

N/A

50
75

ON

ON

N/A

None

ON

100

20

Points

No font name
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SETTING

Font, default (normal character) 1+ >
Font, for endnotes 2

Font, for footnotes 2

Font, for line numbers

Font, normal character 1/ 3
FONTID.CTL for Preview, location of >
Footer and header buffer size

Footer margin

Footer, page number position

Footnote buffer size

Footnote continuation text

Footnote file type

Footnote font 2

Footnote position

Footnote reference mark in note, attribute

Footnote reference mark in note, lead char.

Footnote reference mark in note, trail char.
Footnote reference mark in text, attribute
Footnote reference mark in text, lead char.
Footnote reference mark in text, trail char.
Footnote repeating character table
Footnote separator

Footnote tag type, restart on each page
Footnote tag type, type of reference mark
Footnote, default color to use

Footnote, default ruler to use

Footnote, running format

Footnote, VMI between notes

Footnote, VMI between sep. lineffirst note
Footnote, VMI between text/separator line
Footnote, VMI for each footnote line

Form feed character

General exclusion list file for Indexer >
Go to top of page with AQIl

Graphics conversion file

Graphics conversion settings file
Graphics files directory display
Graphics files file extension

Hard return ending character
Hardware cursor movement
Header and footer size
Header margin

PATH

BCG
DAD2AA
DADAA
DBJA
BCG
CDH
CC2A
DAAE
DABB
CC2E
DADG
DADK
DADAA
DADH
DADDA
DADDB
DADDC
DADCA
DADCB
DADCC
DADB
DADF
DADEB
DADEA
DADAC
DADAB
DADI
DADJA
DADJD
DAD)C
DADJB
DBA4B

DCCA
DCGJ
CD3B
CD3C
CD3D
CD3E

DBA3G
CBCE
CC2A
DAAD

DEFAULT

No font name
No font name
No font name
No font name
No font name
FONTID.CTL(U/3)
4096 bytes
0.33"

Center

8 records
...Continued...
$F$

No font name
0

e

WSINDEX.XCL(U/1)
OFF
TOPIX.EXE(U/7)
TOPIX.SET(U/7)
22222222.222(U/4)
PIX

<
ON

4096 bytes
0.33"
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SETTING

Headers and footers
Height, line 1

Help level

Help overlay file 5

HMI units for ruler line
Horizontal unit of measure
Hyphenation

Hyphenation index file 5 &
Hyphenation overlay file 3
Hyphenation, main data file >
Hyphenator memory on/off

IBM compatible ROM BIOS
IBM counter/timer for beeping
Index every word

Indexer exclusion list file
Initial directory log-on

Insert characters

Inset program file for print-time loading 5
Inset, load at print-time

INT 1C timer interrupt
International characters table
International dictionary file 5 ©

Justification !

Kerning
Keyboard repeat rates 9

Language default

Language, display on status line

Leading (line height) !

Leading, automatic, 120% of text size
Left margin !

Left margin for line number

Letter quality printing !

Line feed character

Line height (leading) !

Line height unit of measure

Line numbering font

Line numbering, continuous

Line numbering, left margin character for
Line numbering, right margin character for
Line numbering, left margin for

PATH

DAB
BC)
DBAA
CDC
DBA2G
DAGA
DBCC
CD5C
CD5A
CD5B
CCB

CBCA
CBCB
DCCB
CD2E
CEE
DBBB
CD3A
BC2C
CBCD
DCGM
CDA4E

DBCA

BC2B
ADA

DCGK
DBA2D
BCJ
BCL
DAAH
DBJD
BCC
DBA4A
BCJ
DAGC
DBJA
DBJB
DBJE
DBJG
DBJD

DEFAULT

N/A

240

4

WSHELP.OVR(U/1)
180

Inches

ON
HYPINO00.DCT(U/1)
WSHYP000.OVR(U/1)
HYPMNO000.DCT(U/1)
ON

ON

ON

OFF
WSINDEX.XCL(U/1)
None

ON

INSET.EXE(U/4)

ON

ON

OFF
SPLIN000.DCT(U/2)

OFF

ON
N/A

1

OFF

240

OFF

0.00"

0.70"

DIS

J

240

Inches

No font name

OFF

(See screen display)
(See screen display)
0.70"
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SETTING

Line numbering, right margin for

Line numbering, space between
number/character

Line spacing 1

Line spacing between line numbers

Log on to directory in file list

Log-on directory, initial

Long busy time-out

Long line character

Longest delay (sign-on)

Lotus international characters

Macro compiler error messages
Macro file, compiler >

Macro file, decompiler >

Macro file, hot key list >

Macro files and path >

Macros

Macros, dollar format for numbers
Macros, format for today’s date
Macros, format for today’s time
Macros, hot key buffer size
Macros, pause for input key
Macros, stop at any time
Macros, stop during playback key
Macros, stop recording key
MailList from Additional menu 3
Main spelling buffer

Main spelling dictionary file 5 ©
Margins for endnotes

Margins for footnotes

Margins, page size and
Maximum characters unerased
Measurements, units of
Medium delay (menus)

Memory usage

Memory usage, EMS

Menu level

Merge print dot command character
Merge print memory

Merge printing

Messages and menus buffer
Messages and menus file 5
Microjustification

PATH

DBJF
DBJH

DBCB
DBJC
CE)
CEE
BDAB
DBA3I
DCGB
DBBH

DCDF
CD2H
CD2I
CD2F
CD2G
DCD
DCDI
DCDG
DCDH
CCG
DCDB
DCDD
DCDC
DCDA
CD3H
CCD
CD4B
DAD2AB
DADAB
DAA
DBEA
DAG
DCGC
CC
CC2G
DBAA
DBA4H
CC2b
DCE
CCF
CDD
BCD

DEFAULT

7.40"
0.30"

1

0
OFF
None
0

+
2000
OFF

OFF

WSC.EXE(U/1)
WSD.EXE(U/1)
WSHOTKEY.OVR(U/1)
22222222 WSM(U/11)
N/A

"l"'l"'/""99

31, 4 (month day, year)
B:C D (hh:mm am/pm)
4 (896 bytes)

Alt+-

Ctrl+Break

Esc

Alt+=
WSLIST.COM(U/6)
N/A
SPLMNO000.DCT(U/2)
0 (default ruler)

0 (default ruler)

N/A

500

N/A

1000

N/A

16 pages

4

4K

N/A

4 records
WSMSGS.OVR(U/1)
DIS
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SETTING

Monitor name

Monitor patches

Monitor selection

Monitor, IBM PC CGA compatible
Monitor, IBM PC compatible, incl. EGA
& VGA

Monitor, IBM PC EGA with 43 lines
Monitor, IBM PC ROM compatible
Monitor, IBM PC VGA with 50 lines
Monochrome display default
Monochrome graphics display default
Mouse, delay before horizontal scroll
Mouse, delay before vertical scroll
Mouse, horizontal motion sensitivity
Mouse, horizontal move before scroll
Mouse for left hand

Mouse support

Mouse support on/off

Mouse, vertical motion sensitivity
Mouse, vertical move before scroll
Multi-user or network system

Near letter quality printing !

Newspaper column file type

No extra soft lines at paragraph end
Nondocument, command line default
Nondocument, print as default
Nondocument, status line filler character

Nondocument, tabs/auto-indent by file type

Nondocument, AB and A*QU strip MSB
Normal (default) character font 1+ 3
Notes (footnotes/endnotes)

Outline style numbering
Overprint line character

Page break character

Page break divider character
Page length

Page number

Page number, initial

Page number, position

Page offset on even pages
Page offset on odd pages

PATH

AAB
AC
AAA
AAAB
AAAA

AAAD
AAAC
AAAE
ABF
ABE
DCHG
DCHH
DCHC
DCHE
DCHB
DCH
DCHA
DCHD
DCHF
CBB

BCC
CD5H
DBHE
DCBA
BCA
DBA2CB
DCBD
DCBC
BCG
DAD

DBIC
DBA3K

DBA4C
DBA3B
DAAA
DABA
DABC
DABB
DAAF
DAAG

DEFAULT

N/A
N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A
N/A
300
300
15

20

OFF
N/A
ON
15

15

OFF

DIS
$D$
OFF
OFF
OFF
“" (blank)

(See screen display)

ON
No font name
N/A

OFF

P
11.00"
ON

1
Center
0.80"
0.80"



CUSTOMIZING WORDSTAR

SETTING

Paragraph ending character
Paragraph margin !

Paragraph numbering separator at end
Paragraph numbering style

Paragraph numbering, outline style
Paragraph style, default

Paragraph styles library file >
Paragraph styles temporary file extension
Path settings, save

Paths, default search

Personal dictionary file 3

Personal dictionary memory

Personal dictionary, always prompt for
Preview file >

Preview work files 5

Print control (command tags) display
Print from keyboard template file >
Print nondocument as default

Print page numbers

Print Wait, beep for

Printer busy test

Printer character input subroutine
Printer character output subroutine
Printer description files

Printer initialization subroutine
Printer input status subroutine

Printer long busy time-out

Printer output status subroutine
Printer overlay files 5

Printer patch area

Printer uninitialization subroutine
Printer, choose a default printer
Printer, choose name for sign-on screen
Printing defaults

Printing, background printing (concurrent)
Printing, busy test for output to printer
Printing, long busy time-out

Prompt “Can’t find that file”

Prompt “Return to WordStar”
Proportional spacing

Pull-downs, turn cursor wrap on/off

PATH

DBA3G
DAAJ
DBIB
DBIA
DBIC
DAFB
DAFA
DAFC
CD6E
CDA
DCAD
DCAG
DCAEC
CDF
CDG
DBAB
CD2D
BCA
BC2A
BDCB
BDAA
BDBF
BDBD
CD2B
BDBA
BDBE
BDAB
BDBC
CD2A
BDBG
BDBB
BA

BB

BC
BDCA
BDAA
BDAB
DBA2]
DBA2I
BCF
DBA2F

DEFAULT

<
(none)

OFF

1.1.1.1.1.1.40

OFF

Body Text
WSSTYLE.OVR(U/1)
$G$

N/A

N/A
PERSONAL.DCT(U/2)
2K

OFF
PREVIEW.OVR(U/3)

ON
KEYBOARD.MRG(U/1)
OFF

ON

ON

ON

N/A

N/A
22222222.PDF(U/1)
N/A

N/A

0

N/A

22222222, OVR(U/1)
N/A

N/A

DRAFT

Draft Printer

N/A

ON

ON

0

ON

ON

DIS

ON
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SETTING PATH DEFAULT
RAM resident, WordStar CCA OFF

RAM, put characters directly in video RAM  CBCC ON

Reset all settings EC N/A
“Return to WordStar” prompt DBA2I ON
Reverse bright/dim ACCC N/A

Right margin ! DAAI 6.50"
Right margin for line number DBJF 7.40"
ROM BIOS, IBM compatible CBCA ON

Ruler line, 1st stored DAEB Quotation
Ruler line, 2nd stored DAEC Hanging Indent 1
Ruler line, 3rd stored DAED Undefined
Ruler line, 4th stored DAEE Undefined
Ruler line, 5th stored DAEF Undefined
Ruler line, 6th stored DAEG Undefined
Ruler line, 7th stored DAEH Undefined
Ruler line, 8th stored DAEI Undefined
Ruler line, 9th stored DAE) Undefined
Ruler line, default ! DAEA Body text
Ruler line display DBAH ON

Run a DOS command prompt DBA2I ON

Save all settings in file EB N/A

Save color settings in file ACD N/A

Save path settings in file CD6E N/A

Save WSCHANGE changes and exit AXY N/A
Screen colors, alternate color palette 1 ABC N/A
Screen colors, alternate color palette 2 ABD N/A
Screen colors, color display default ABB N/A
Screen colors, monochrome display alternate ABE N/A
Screen colors, monochrome display default ~ ABF N/A
Screen colors, reset to shipped default ABGD N/A
Screen colors, select individually ABA (See screen display)
Screen height AACA 25

Screen size, horizontal scroll width AACC 20

Screen width AACB 80

Scroll bar display DBAJ ON

Scroll speed DBBG 3
Separator between data items DCEA ,

Short delay (doc align) DCGD 200
Sign-on message DCGA None
Single user system CBA N/A
Smallest word checked DCAH 2

Snaking column character DBA3D (See screen display)
Soft return ending character DBA3H “* (blank)
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SETTING

Soft space character
Soft space display
Sort order for block sort

Special characters, patching

Spelling check defaults
Spelling check options

Spelling checker overlay 5/ ©
Spelling, “Words checked” prompt

Spelling, main buffer

Spelling, watch progress of spelling check

Status line display

Status line, display language
Status line filler character, document mode
Status line filler character, nondocument mode

Status line location
Stored ruler lines
Strikeout character

Style bar display

Style bar location
Subscript/superscript roll
Suppress blank lines

Suppressed blank line character

Tab stops, decimal 1+ 4
Tab stops, regular 1,4

Tabs and auto-indent by file type (nondoc.)
TelMerge from Additional menu >

TelMerge system file

Temporary block file type
Temporary text file type, backward editing
Temporary text file type, forward editing

Text spillover

Thesaurus definitions overlay ° ©
Thesaurus dictionary file 5 ©
Thesaurus overlay file 5/ 6
Thousands number separator
Time format for &!& variable
Time format for insert current time

Title bar display
Top margin

Turn “Can’t find that file” on/off
Turn “Return to WordStar” on/off

PATH

DBA3A
DBAD
DCFC
ACA
DCA
DCA2
DCAA
DCAL
DCAF
DCAK
DBAI
DBA2D
DBA2CA
DBA2CB
DBA2B
DAE
BCl
DBAG
DBA2A
BCK
DAAK
DBA4)

DACB
DACA
DCBD
CD3F
CD3G
CD5G
CDS5F
CDS5E
CCG
CD4H
CD4G
CD4F
DBFJ
DCED
DCDH
DBAF
DAAB
DBA2)
DBA2I

DEFAULT

(See screen display)
OFF

N/A

N/A

N/A

N/A
WSSPL0O00.OVR(U/2)
ON

65535

OFF

ON

OFF

(blank)

(blank)

BOTTOM

N/A

ON

TOP

90

OFF

(See screen display)

None

(See screen display)
(See screen display)
TELMERGE.EXE(U/5)
TELMERGE.SYS(U/5)
$C$

$B$

$A$

0
DEFIN000.DCT(U/2)
THESR000.DCT(U/2)
WSTHS000.OVR(U/2)

B:C D (hh:mm am/pm)
B:C D (hh:mm am/pm)
ON

0.50"

ON

ON
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SETTING

Turn “Words checked” message on/off
Turn cursor wrap on pull-downs on/off
Turn spelling check on/off

Type ahead buffer flush control

Underline blanks

Unerase buffer

Unerase single character erasures
Unit for all measurements
Unknown dot command character

Valid disk drives

Variable name indicator

Vertical cursor movement

Vertical unit of measure

Video attribute subroutine

Video attributes

Video RAM, put characters directly in
VM units for line height

Watch progress of spelling check
Watch progress of AQU alignment

Window prompt for document/nondocument

Window separator character
Window, size of other
Word wrap at right margin !
“Words checked” message
WordStar compatibility
WordStar files

A6 hard to soft carriage return/auto-align
AB and AQU strip MSB in nondocument
AH moves left (not erase left)

AN split line (or hard return to soft)

AQI goes to top of page

AQU, watch progress of AQU alignment
AQX goes to right side of screen

PATH

DCAL
DBA2F
DCAI
ADB

BCE
CcCl
DBEB
DAGE
DBA4I

CAA
DCEB
DBH2C
DAGB
ACCA
AB
CBCC
DBA2H

DCAK
DBCG
DCGG
DBA4E
DCGH
DBBA
DCAL
DBH
CD

DBHB
DCBC
DBHA
DCGF
DCGJ

DBCG
DBHH

DEFAULT

ON
ON
ON
OFF

OFF
500 bytes
OFF
(Mixed)

?

(All drives valid)

&

0
Inches
N/A
N/A
ON
240

OFF
OFF
OFF
w
128
ON
ON
N/A
N/A

OFF
ON
OFF
ON
OFF
OFF
ON
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WSCHANGE CHART NOTES

1

This setting should be changed in the default paragraph style (usually
Body Text).

If you change the default printer or the default setting for the normal charac-
ter, alternate character, endnote, footnote, or line numbering font, your
PDFs must be in the main WordStar directory (usually WS). Otherwise,
WSCHANGE can’t find them.

Auto-backup works only with IBM computers that have a ROM BIOS date of
11/85 or later.

When you set tabs in WSCHANGE, be sure to set them in ascending order
(2", 4", 6". If you set them in descending order (6", 4", 2"), they won't take
effect.

The default search paths shown assume you installed WordStar with
WSSETUP and didn’t change the directory names.

Some spelling, thesaurus, and hyphenation filenames contain “000.” The
actual filenames on your WordStar disks have “001” in the filename. The
“000” in WSCHANGE tells WordStar that multiple languages can be used.
The “001” in the filenames on disk tells WordStar you’re using the American
English (as opposed to British English) version of those files. (If “001” were
used in WSCHANGE, you would be able to use only the American English
version of the spelling, thesaurus, and hyphenation files.)

Turning the directory display off in WSCHANGE does not affect help level 4
(pull-down menus). The directory is always displayed at help level 4.

When you set WordStar not to pad out the last record of your file with
AZ (SETEOF), only nondocument files are affected. In document files, Word-
Star always pads out the last record.

The keyboard repeat rates work only with IBM computers that have a ROM
BIOS date of 11/85 or later.
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This section includes instructions for
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1 Fine-tuning Preview to Display Fonts
0 Patching WordStar Manually and Using the Auto-patcher
0 Setting Paths for WordStar Files

O Advanced Customizing of PDFs

FINE-TUNING PREVIEW

Preview works correctly on most computers. However, if you have trouble
getting it to work properly on your computer, or if you want to improve the
display, you can make several adjustments. For example, you can specify a
different type of monitor, change the page size, or adjust the screen fonts. To
make these adjustments, you edit a configuration file in WordStar named
FONTID.CTL.

CAUTION Before you edit FONTID.CTL, make a copy of the original file.
Then if you make any errors, you can use the original file.
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EDITING THE FONTID.CTL FILE
Preview uses the FONTID.CTL file to get information about these items:
= Type of graphics card being used
= Aspect ratio of the monitor display
= Grid type used in the display
= Page size being previewed
= Background color of the page

= Size of the top and left offsets for nonprinting areas of the page
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= Resolution for fax files
= Screen fonts (.\WSF files) installed

The above items are preset in WordStar; however, you can change any of them.
To change a setting in the FONTID.CTL file, you edit that file as a nondocu-
ment file in WordStar. The FONTID.CTL file is maintained by the PRCHANGE
DISPFONT, and Preview programs. However, if you need to edit the file, keep
the following points in mind:

7

= You must edit FONTID.CTL as a nondocumentfile.

= After you edit FONTID.CTL and save the file, you must exit WordStar for
your changes to take effect.

= [f you delete a font entry from the table in FONTID.CTL, you can no longer
preview that font.

= |nvalid font entries, or those that have no corresponding .WSF files, will be
removed from FONTID.CTL. If you delete a .WSF file, the corresponding
entry is removed from FONTID.CTL.
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CHANGING THE PREVIEW DISPLAY

SPECIFYING A MONITOR  In the FONTID.CTL file, the Display Adapter Type
is defined by the line CRT_TYPE=n. If nis blank, the monitor type is selected
automatically. In the monitor list, adapters marked with NA must be selected
manually. For example, the Cirrus VGA 16-color adapter looks like this in

the file:

; NA 8 = 800 X 600 CIRRUS VGA (16 COLOR)
To choose that adapter, you would type 8 as the code after CRT_TYPE=.

If your monitor isn’t supported for Preview (see the “Printers and Monitors

List”), try using O (monochrome) or 1 (color) as the monitor code. Also, check
with the monitor manufacturer to see if a special WordStar graphics driver file is
available. If you have a WordStar graphics driver file for your monitor, type the
filename after CRT_TYPE=.

CAUTION When you change the monitor type, run Preview before you
make changes to any files. The wrong monitor type could hang up the system
and lose data.

If you're using a monochrome VGA card, and you get a blank screen after you
exit Preview, type mode bw80 at the system prompt. (The DOS MODE.COM
file must be on your path.)

If you have a laptop with a VGA LCD display (monochrome) and you want to
improve your display, try the VGA MONO selection.

Note: If your graphics adaptor card is SUPERVGA and will run at 1024x768,
check the manual to see if it has a VESA Bios driver. This driver remains in
memory and supports a standard interface. With the VESA driver loaded,
specify CRT_TYPE= VESA1024.WGD. This should support your SUPERVGA in
high resolution 1024x768 mode.

ADJUSTING THE ASPECT RATIO You can change the Aspect Ratio to make
the horizontal and vertical inches equal in the Preview display. To see the
Aspect Ratio, press O and then G to turn the Grid option on. See if the
horizontal and vertical grid marks are about the same. If they aren't, edit
FONTID.CTL and type a positive or negative number after ASPECT= (for
example, -10) to adjust the horizontal grid marks. Positive values make the
grids wider, while negative values make the grids narrower.
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USING DIFFERENT GRID TYPES You can choose from five different grid
types by editing the GRID_TYPE= line in FONTID.CTL.

Pica Grid (6 dots per inch)

Inch Grid (10 dots per inch)

Inch Grid (4 dots per inch)

Centimeter Grid (2 dots per centimeter)
Centimeter Grid (5 dots per centimeter)

GThHh WN =

After GRID_TYPE=, type a number from 1 to 5. The dots per inch are the refer-
ence dots you see in Preview when Grid is on, and not the printed dots per
inch. Unless you change it, the Grid Type is 2 (10 dots per inch).

DISPLAYING DIFFERENT PAGE SIZES You can change the display page size
by editing the PAGE= line in FONTID.CTL. After PAGE=, type the horizontal
inch measurement, an “X,” and the vertical inch measurement. For example,
to preview a document on legal size paper, you would type 8.5X14.
FONTID.CTL includes a few PAGE= comment lines (preceded by semicolons)
for standard page sizes other than the default letter size. To use one of the
standard page sizes listed, remove the semicolon from the PAGE= line you
want to use. Then add a semicolon preceding PAGE=8.5X11.

Preview switches between portrait and landscape pages using the default setting
PAGE=8.5X11.

Note: If you prefer, you can use commas as decimal points when you type the
page size.

CHANGING THE BACKGROUND COLOR You can change the background
color of the previewed page by editing the PAPER_COLOR= line in
FONTID.CTL. After PAPER_COLOR=, type a number from 0 (black) to

15 (white). The colors may vary from monitor to monitor. Remember that
black text isn't visible against a black page.

REVERSING COLORS |If you're using a laptop or any other monitor that
reverses colors, Preview displays white text on a black background. To
return to the normal display of black text on a white background, type 1
after INVERSE=,

SETTING THE TOP AND LEFT OFFSETS You can set an offset in decipoints
(one decipoint = 1/720 inch) to allow for the areas of the page. If you set the
top and left offsets to 180, Preview adds .25 inch to the top margin and page
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offset values. The default offsets are 0. If you change printers, you may have to
change the offsets manually.

Note: Top and left offsets also affect the alignment of text on fax pages.

CHANGING THE RESOLUTION FOR FAX FILES Most fax machines have a
resolution of 200 dots per inch (dpi) horizontally. The vertical resolution is
either 200 (high) or 100 (low) dpi. Send fax files in the same resolution in
which they were created.

WordStar’s fax file output supports both high and low resolutions. The default
output resolution in FONTID.CTL is high, represented by the statement
FAX_RES=1. The statement for low resolution is FAX_RES=0. The statement for
300x300 dots per inch is FAX_RES=2. The setting that you choose needs to be
supported by your fax machine. The high resolution produces better-looking
fax output. Phone line charges are less for normal resolution but the fax output
isn’t as satisfactory.

When you request fax files from either the Opening screen or the Editing
screen, you enter the resolution in the Fax dialog box. The settings in the Fax
dialog box override settings in FONTID.CTL. However, when you create fax
files from within Preview, WordStar uses the FAX_RES setting in FONTID.CTL.

You can select settings in FONTID.CTL that allow you to create .PCX files in the
correct resolution for dot matrix printers. These are not fax files. The statement
for a 9-pin dot matrix printer is FAX_RES=3. The statement for a 24-pin dot
matrix printer is FAX_RES=4.

Note: You need to obtain a utility (not supplied by WordStar) to print the .PCX
files for the 9-pin and 24-pin dot matrix printers.

ADJUSTING THE SCREEN FONT DISPLAY

When you create screen fonts (.WSF files) in PRCHANGE or the DISPFONT
program, information about each font is stored in the FONTID.CTL file.
Preview cannot display a typestyle unless it’s in FONTID.CTL. If WordStar
can’t find the font, it displays the best match it can find.

WordStar supplies four groups of screen font (WSF) files. The files are used
when WordStar can’t find a better match for your font. The four groups are
named as follows:
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NAME
COURIER

NPSHLV

UNIVERS

TIMES

CHARACTERISTICS

Fixed pitch serif font for typefaces like Courier and
Prestige Elite

Fixed pitch sans serif font for typefaces like Line Printer
and Gothic

Proportional sans serif font for typefaces like Helvetica
and Triumvirate

Proportional serif font for typefaces like Times Roman and
Century Schoolbook

Each screen font group above includes four files for regular (1), italic (2),
bold (3), and bold-italic (4) fonts.

When you create a screen font in PRCHANGE or DISPFONT, the font is
assigned a seven-character name; for example, 0512USR.WSF, where

05
12
us

R
WSF

HP Typeface ID number (05 = Times Roman)

Point size

Symbol set (US = USASCII)

Weight/style (R=Regular, B=Bold, I=Italic, ]=Bold-Italic)
WordStar Screen Font

The font section of FONTID.CTL uses this format for screen fonts:

01= UNIVERS1,180 093 C034 341

FILENAME OR #

01
UNIVERS1
180

093

C034

341

REPRESENTS

Sequence number

Screen font filename (.WSF)

Height (1/720 inch, or point size x 10)
Average character width (1/720 inch)
Key for typeface and characteristics
HP symbol set number

Note: If you add a font to FONTID.CTL manually, you need to enter only the
sequence number and the screen font filename. Preview calculates the other

values.
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How PREVIEW SELECTS SCREEN FONTS

Preview needs only one size of each screen font to display that font in any size
(size is not a selection criterion as it is in printers). Preview chooses which font
to display based on the following priorities:

= Math/Symbols/Text (850 or 437) symbol set
=  Proportional/Fixed

= Specific typestyle

» PC-850/PC-8 (code page 437) symbol set

= [talic/Upright

= Bold/Normal weight

= Serif/Sans serif/Display/Script

If Preview finds more than one “best match,” WordStar uses the one that
appears last in the FONTID.CTL file. FONTID.CTL does not contain duplicates
unless you force them (see “Making Screen Fonts”).

MAKING SCREEN FONTS

To make the best looking Preview display, create screen fonts from the same
fonts you’ll use for printing. Otherwise, the screen fonts may look slightly dif-
ferent than the printed fonts. The symbol set should be either PC-8 or PC-850
since WordStar maps those symbol sets to the fonts in your printer. You can
use the USASCII symbol set if you want to achieve smaller font files or to allow
greater resolution of screen fonts. This symbol set, however, does not display
extended characters.

MAKING SCREEN FONTS AUTOMATICALLY When you install soft fonts, you
use LSRFONTS to create a custom font database containing the fonts you want
to preview. Then you use PRCHANGE to install the custom fonts in your PDF.
(See “Adding Custom Fonts” in “Customizing WordStar” in this booklet.)

After you add the fonts to your PDF, you'll see the prompt Do you want to
create screen fonts? Y/N. If you press Y, PRCHANGE scans all the fonts in
your PDF and makes the necessary screen fonts.
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When adding screen fonts, keep these points in mind:

= Only one screen font is needed for each typeface/attributes/symbol set
combination because Preview scales the screen font to the correct size.
Larger fonts make better-looking screen fonts, but they also take up more
disk space than smaller fonts. Start with 18-point fonts, and then try larger
or smaller fonts, depending on whether you want better resolution or more
disk space. For the USASCII symbol set, 30 points produces optimum
results.

= The size limit for .WSF files is 48K, and the limit for the largest single
character in a font is 4K. If either limit is exceeded, the .WSF file will not
be created. If you can, use smaller soft fonts to build the screen fonts.

=  Symbol sets in the same group are considered duplicates, but PC-8 and
PC-850 symbol sets override other symbol sets in the same group.

= Only bitmapped (HP Laserjet series Il and compatible) soft fonts can be used
to create screen fonts. Scalable (HP Laserjet Il and compatible) and
compressed (HP Laser)et IIP and compatible) fonts will not work. If you use
Type Director or another soft font generator to create soft fonts, set up the
program to make soft fonts for HP Laseret Series Il and compatible printers.
First create an 18-point font, and then create a screen font from it by
running DISPFONT.

= If you don’t think your font was added to FONTID.CTL, or if the screen font
doesn’t match the printed font, try creating the font manually.

MAKING SCREEN FONTS MANUALLY If you make screen fonts in
PRCHANGE, and you do not like the screen font size selected, you can force
DISPFONT to make the screen font in another size.

To make a screen font, log on to the directory where FONTID.CTL and the

* WSF files are located (usually WS). Make sure your path includes the direc-
tory where DISPFONT.COM and DISPFONT.OVR are located (usually WS).
Type dispfont fontname, where fontname is the name of the soft font file
(including the path, if needed), and press Enter. (You can use a wild-card
specification to enter filenames, for example, *.SFP.) DISPFONT creates a
WSF file (a screen font) and displays the filename or displays an error message
telling you why it can’t create the screen font. Each time DISPFONT creates a
screen font, it updates the FONTID.CTL file.
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DISPFONT doesn’t normally create a duplicate font, but if you want to force
creation of a duplicate font, type dispfont fontname f and press Enter. You may
want to force a duplicate font if, for example, a screen font was originally
created in a very small point size and you want better resolution. The “f” for
“force” works with wild-card characters, but you need to be careful. If you type
dispfont *.sfp f you may add a lot of duplicates into your FONTID.CTL table.
The FONTID.CTL table should not really go beyond 60 entries, and fills up at
99 entries.

CAUTION Duplicate screen fonts may just be different symbol sets
belonging to the same group, for example, Courier 10 PC and Courier 10 US.
ASCII and PC-8 are considered equivalent, but PC-8 is preferred because it
includes more characters. If you override a PC-8 font with an ASCII font, you
can’t display the entire character set.

ADDING EXISTING SCREEN FONTS

If you want to add screen fonts (.WSF files) that are stored on a floppy disk or in a
network directory, you can use DISPFONT to copy the font into the current direc-
tory. Type dispfont drive/directory filename and press Enter. For instance, to
add all the screen fonts on a floppy disk located in drive A, type dispfont a:*.wsf
and press Enter. (Be sure to include the location of the font files, or the screen
fonts will be added twice.) The DISPFONT program copies the screen font files
from the floppy disk to the current directory and updates FONTID.CTL.

TROUBLESHOOTING SCREEN FONT PROBLEMS

The problems described below may occur when you create screen fonts.

YOU ADD A NEW FONT AND EVERYTHING DISPLAYS IN THAT FONT If this
occurs, the fonts in your PDF may not match the default screen fonts. When
Preview doesn’t find an exact match, it looks for the closest match. If it finds
more than one “closest match,” it uses the last one in the list in FONTID.CTL.
When you add fonts, those fonts are last in the list and are used before any of
the default fonts. Edit FONTID.CTL and move the last font to the top of the font
list. Then carefully renumber the list, starting with sequence number 01.
Delete the VER= line, save the file, and then exit WordStar and restart it. If
there are gaps or duplicate numbers in the font list, the list will be renumbered
when you start Preview.

For example, if all the fonts in your PDF are Roman-8, and you add one special
Roman-8 screen font, Preview may choose the new font for all fonts since it is

the only one that has the correct symbol set. You can either make screen fonts
from your Roman-8 fonts or build a PDF that uses the PC-8 (the default) symbol

3-9
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set for all the other fonts. Making fonts with the correct typeface number
usually helps, even if the symbol set is wrong.

CRT FILES ARE FILLING UP YOUR HARD DISK CRT files are created for each
size of each font you display. They are not deleted automatically except when
the “VER="line in FONTID.CTL is removed. However, you can remove CRT
files at any time, and Preview rebuilds them as needed. Log on to the directory
where Preview keeps its files (usually WS); this directory has one or more
subdirectories with .CRT extensions. Make sure the directory with DELCRT.EXE
is on your DOS path, and type delcrt and press Enter. (If you need to, specify
the path; for example, c:\ws\delcrt.) DELCRT searches for files and
subdirectories with the .CRT extension and deletes them.

CREATING SCREEN FONTS FOR FAX FILES

Preview creates fax images similar to the way it creates screen images. It may
help you to think of the fax machine as a 200 dpi printer. You want to get the
best looking print quality using the output from Preview. To achieve the best
looking fax fonts, just as in Preview, you start with the best original fonts.
WordStar starts with HP LaserJet bitmapped fonts and converts them to com-
pressed .WSF files. Only one size of each typeface is required. Preview scales
the fonts at display time to match the size of type desired and the size and
shape of your graphics screen.

Your WordStar package contains a selection of screen fonts. These fonts
adequately display smaller point sizes. For larger point sizes, you can produce
much better fonts by starting with larger original fonts.

SELECTING A SYMBOL SET

3-10

The symbol set that you use affects the font size. The USASCII set has much
smaller font files. We recommend that you use the USASCII symbol set if
you don’t require international characters and line and box symbols in your
documents.

Note: Preview cannot handle a screen font over 48K or a scaled bitmap over 64K.
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The following chart shows the quality of fonts produced from various point
sizes and symbol sets. The results were obtained from a Compugraphics
CG TIMES Bold font.

FAX FONT 10 PT. ORIG. 18 PT. ORIG. 30 PT. ORIG.
SIZE PC-8 PC-8 USASCII
10 pt. Good Excellent Excellent
12 pt. Good Excellent Excellent
18 pt. Fair Excellent Excellent
24 pt. Fair Excellent Excellent
30 pt. Fair Fair Excellent
40 pt. Poor Fair Excellent
50 pt. Poor Fair Fair

60 pt. Poor Poor Fair

72 pt. Very Poor Poor Fair

The recommended original fonts to use for fax files are 18-point, PC-8 symbol
set, or 30-point, USASCII.

Note: The PC-850 symbol set has the same size .WSF files as the PC-8 symbol
set, because the number of characters in the symbol sets is the same. Legal has
the same size .WSF files as USASCII.

USING DISPFONT TO CREATE FONTS

You create screen fonts for Preview using the utility DISPFONT. DISPFONT
takes an HP LaserJet bitmapped, portrait font, and converts it into a WordStar
Screen Font (.\WSF) file. If you have a Laser]et Il or |lI printer, you probably
already have several downloadable bitmapped soft fonts. If you are using a
special font that you purchased, like Old English or a script font, you can
probably use it with DISPFONT. For more information on the DISPFONT
program, see the previous section in this chapter called “Adjusting the Screen
Font Display.” '

Note: Currently, DISPFONT only converts HP Laseret fonts. If you don’t have
any soft fonts, you can contact WordStar for a disk of USASCII screen fonts at
30 points. These are for CG-Times and Univers fonts.
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LASERJET SERIES II SOFT FONTS

Use the following steps to create screen fonts for LaserJet Series Il soft fonts.

1 Determine the largest point size available from your soft fonts (around 30-
point for USASCII or 18-point for PC-8).

2 Log on to the directory where the FONTID.CTL resides (usually WS).
3 Type dispfont \fontpath\fontname f and press Enter.

For example, type dispfont c:\myfonts\tr300rpn.usp f. The “f” in this com-
mand means “force duplicate creation.” DISPFONT overwrites a similar
font that exists in a smaller size. When you type the command, DISPFONT
creates a screen font file (WSF) and an entry in the FONTID.CTL file.

LASERJET III SCALABLE FONTS AND
LASERJET II-P COMPRESSED FONTS

DISPFONT cannot directly read the LaserJet lll scalable fonts and Laserjet lI-P
compressed fonts. Use Type Director or some other font-scaling program to
create Laserjet Series 1l soft fonts in portrait orientation, in the desired symbol
set, and at the recommended point size (see the previous section “Selecting a
Symbol Set”). Then use DISPFONT to create screen fonts using the information
described in the previous section “Laserjet Series Il Soft Fonts.”

CARTRIDGE AND INTERNAL FONTS

To Preview or fax cartridge or internal fonts, you need to use a bitmapped
version of the same (or close to the same) font. Many cartridges come with
machine-readable bitmapped versions on disk. If you can get the bitmapped
fonts into HP Laserlet Il format, you can use them to create screen fonts.
Otherwise, you may be able to use a standard font (like Times) which closely
approximates other fonts such as Century Schoolbook.

NON-HP PRINTER FONTS

If you purchased scalable fonts from a vendor and installed them for your
printer, see if the font scaler program can also make HP Laserjet Il fonts (most
scaler programs can do this). After you create the HP LaserJet Il fonts, follow
the instructions in the above section “Laser)et Series Il Soft Fonts.”
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ADOBE FONT FOUNDRY

DISPFONT needs HP Laser]et bitmapped fonts to create screen files. If you
have PostScript fonts, you can use the Adobe Font Foundry program to build
bitmapped font data from your PostScript fonts. We recommend building an
HP bitmapped font of 14 to 18 points using the USASCII symbol set. The larger
the point size, the more disk space the font requires but the resolution is better.
For instructions on how to use the Adobe Font Foundry software, see the
Adobe Type Library, User Guide.

PAtrcaine woRDSTAR

When you patch WordStar, you customize it by editing the program codes.
Instead of answering prompts and letting WSCHANGE make the changes for
you, you enter the hexadecimal codes yourself. You can patch any item in the
user area of the WS.EXE program file. You’ll find a listing of the contents of the
user area in the PATCH.LST file. The pages that follow describe the user area
and the PATCH.LST file, and give instructions for using patching menus and the
WordStar auto-patcher.

CAUTION Patching is a very technical procedure and is recommended for
advanced users only. Mistakes in patching can have far-reaching effects on
WordStar, so be sure to make a copy of the WS.EXE program file before you
begin. That way, if your patches don’t work as expected, you can go back to
your original version.

Be careful when using patches from a previous version of WordStar. Patches
that refer to data addresses may have disastrous results in WordStar because the
data has been moved. However, patches that refer to user area labels may
work because most labels haven’t been changed. Do not read in any patch
files without checking the PATCH.LST file first. (For more information about
patching from previous versions of WordStar, see the booklet Upgrading from a
Previous Release and the section in this chapter called “Transferring Customiza-
tions Using the Auto-patcher.”)

3-13
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ABOUT THE USER AREA

All WS.EXE customizations are made in the user area of the WS.EXE file. The
user area is made up of many small sections, each of which affects a certain
part of the program. Many sections have identifying labels; for example,
LGLDRY refers to the legal disk drives section and HITE refers to the screen
height section.

Each section in the user area contains data (some sections have only one data
item); the label is associated with the first data item. Each data item has its own
address, that is, a consecutive hex number, based on the location of the data.
An address may change if the data is moved between releases of WordStar; -
however, labels always refer to specific data and they move with that data.

ABOUT THE PATCH.LST FILE

You'll find PATCHLST.EXE in the directory containing your WordStar files
(usually WS). To decompress the file, log on to the WordStar directory,
type patchlst, and press Enter. PATCHLST.EXE decompresses to the

file PATCH.LST.

Before you make any changes to PATCH.LST, print the file and determine what
areas you want to change. PATCH.LST has a large right margin, so either print
it in a small font or print it sideways on the page (if your printer allows).

Remember that PATCH.LST is just a readable copy of the user area; the user
area itself is part of the WS.EXE program file.

The user area combines program code and English words. The following chart
shows the part of the user area listing; it doesn’t necessarily contain correct
addresses or default settings.

OF30 FF iniedt db TRUE Right justification

OF31 db  TRUE Word wrap when typing
OF32 db  TRUE Insert on
OF33 db  TRUE Print codes displayed

In the example above, the text (to the right) describes the function of the
section. The address (on the far left) indicates where the data appears in the
user area. The addresses are in ascending order and appear as hexadecimal
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numbers. If a line has more than one data item, the next address is incre-
mented accordingly.

Sometimes a label is shown next to the address. When you patch WordStar,
you can specify either the label or the address. The label applies only to the
first data item in a section; subsequent data items don’t have labels. You can
use labels such as INIEDT+1 and INIEDT+2 to refer to the subsequent data
items.

DB (define byte) or DW (define word) on each line is the assembler directive
that defines the data; for example, DB 3 means to define a byte containing the
number three, and DW 1 means to define a word containing the number one.
A word is a data item with two bytes (16 bits) stored in two successive bytes,
with the low-order byte first; for example, DW 12EFH means to store the

hex word 12EF in the two bytes. The first byte contains EF and the next byte
contains 12.

The data that follows DB or DW can be (1) a number, (2) TRUE or FALSE,
(3) a string, or (4) DUP (duplicated). TRUE is the same as hex FF (equal to ON);
FALSE is the same as hex 00 (equal to OFF).

A string is several characters for which ASCII codes are stored in successive
bytes. Strings in the user area listing are surrounded by single quotes; for
example, the string ‘ABC’ is stored in three bytes as hex 41, 42, and 43

(the ASCII codes for A, B, and C, respectively).

If DUP follows DB or DW, it means the value in parentheses is to be duplicated
several times; for example, 10 DUP (0) means the value zero is to be duplicated
ten times. At the end of each line in the user area listing is a comment that
describes the data. Usually these comments provide the most technical infor-
mation about the data.

USING PATCHING MENUS

To patch changes in the user area, begin at the WSCHANGE Main Menu. Type
the letters for your menu selections until you get to the patching menu you
want. Choose an item from the menu or press the equal sign = to go to any
other location in the user area.
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If you press =, you’re prompted for an address or label from the user area. It's
best to use labels because addresses can change from one version of WordStar
to another. (You can also use label calculations such as LGLDRV+1.)

Once you specify what area to patch, WSCHANGE displays the address, the
current value (in hex) for the 16 bytes beginning at that address, and their ASCI|
equivalents, as shown in the following example:

0575 C3 9090 C3 BEA6 06 2EBAO04E3 4EBAE08A36.......... N...6

WSCHANGE displays 16 bytes of information at a time, regardless of the size
of the data item. After you change the sixteenth byte, the next 16 bytes appear.
If the data is only 6 bytes long, you'll see those 6 bytes plus 10 bytes from the
next data item. The address at the left of the screen is for the first

16 bytes on the screen.

To the right of the address, the bytes are shown as hexadecimal numbers.
Beyond those are the ASCII equivalents for the bytes. (If a byte is not in the
range of hex 20 to 7E, it is not a displayable character and it appears as a dot.)

The cursor is located at the first digit of the first byte at the address shown. To
change the byte at the cursor, type any of the patch commands shown below.

COMMAND PURPOSE

' (single quote) Changes the value of the digit pair at the cursor to that of
any ASCll character. Type a single quote () and the ASCII
character, for example, ’A. WSCHANGE translates this into
the proper hex equivalent (in this case, 41h).

0-9, A-F Changes the hex value. Each hex digit must be either a
number or a letter between A and F.

. (period) Redisplays the line showing any changes you’ve made.

J (Enter) Leaves the byte above the cursor unchanged and advances

to the next byte.
X Saves your changes and returns to the menu.
Backspace or AH  Corrects typing errors.
AC Cancels your changes and exits WSCHANGE.
AX Saves your changes and exits WSCHANGE.
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CREATING AND EDITING PATCH FILES

If you want to transfer your changes to another copy of WordStar, you can use
the WordStar auto-patcher (instructions appear in this section). If you don’t
want to use the auto-patcher, you can create and edit the patch files yourself.

A patch file is a nondocument file that lists the starting location for the patch
and the hexadecimal codes to be entered at that location. Use nondocument
mode in WordStar to create or edit a patch file.

Here’s an example of a patch file that patches 16 bytes in the user area. The
patch starts at the label INILOG, which is the initial directory log-on setting.
The log-on directory is changed to C:\WS\LETTERS:

INILOG=0D,43,3A,5C,57,53,5C,4C,45,54
=54,45,52,53,00,00

The label INILOG followed by an equal sign (=) indicates where the patch
starts. You can also use an address calculation, such as INILOG+5, or a hex
address. The first byte, 0D, tells how long the string is. Notice that the second
line in the above example begins with an equal sign rather than an address.
This signifies a continuation of the previous line. The auto-patcher can only
handle lines that are shorter than 128 characters, so use this method to break
up long patches. The hex value for each byte follows the equal sign.

Add strings to the file by surrounding them with either single or double quotes
as shown in the following example:

INITID='Special test version’,0D,0A,00
TRMINI=FF,ERASCR,ERASCR/100

WordStar evaluates the values between the commas and to the right of the
equal sign as byte values. They are always evaluated as modulo 256. How-
ever, all arithmetic is done with words (16-bit values) and all numbers are
assumed to be hexadecimal. Calculations are evaluated strictly from left to
right and parentheses cannot be used.

You can use these operators in calculations:

+ (add) * (multiply) | (and)
— (subtract) / (divide) A (or)
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For more information on patching specific areas of the program, see the
PATCH.LST file.

USING THE UDATE LABEL

If you patch any of the following labels from WordStar 7.0, you should place a
UDATE label on the first line of the patch file:

BFRSIZ HPFILE MLFILE STFILE
CFFILE HYFILE MORPAT TDFILE
DDFILE IDFILE MSFILE THFILE
DEFPTH INIEDT NOTYPE TMFILE
DSTKSZ ISFILE NWFLG UDATE
EMSMEM IXFILE PDFFILE UDFILE
EXFILE KBFILE PRFILE VCOLOR
EXTKB KBXLAT PVFILE VIDATT
FNFILE LNGCOD PVWEFILE WRKTYP
HDFILE MDFILE SCMARK

HIFILE MEMFLG SPFILE

A patch file created by the auto-patcher in WordStar 7.0 includes a product
release date (UDATE) on the first line of the file; patch files from previous
versions of WordStar don’t have a release date. If a patch file (created either
manually or by the auto-patcher) has no date on the first line, WSCHANGE
determines that you're upgrading and won’t patch the labels in this list. The
labels that are listed have changed significantly from earlier versions of
WordStar and patching from an earlier version would cause problems in the
current program.

To find the correct UDATE code for your patch file, look for UDATE at the end
of the file PATCH.LST. The label that you type in the patch file should look
similar to this and contain the correct hex code:

UDATE=db, ##, ##, ##

Note: If your patch file from an earlier version of WordStar has the labels WID,
UDMEM, or SPLMEM, they are patched as the new labels WIDE, UDCMEM,
and SPMMEM.
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TRANSFERRING CUSTOMIZATIONS USING THE AUTO-PATCHER

You can use the WordStar auto-patcher to transfer customizations from one
copy of WordStar to another. This is useful if you're upgrading to a new release
of WordStar or if you want to trade customizations with another WordStar user.

To transfer customizations, you first save the customizations to a patch file, then
you edit the patch file (if necessary), and then transfer (patch) the customiza-
tions to the program file you want to customize.

WordStar can determine if you're using a patch file from a previous version of
WordStar. A patch file created by WSCHANGE in the current version of
WordStar includes a product release date on the first line of the file; patch files
from previous versions of WordStar don’t have a release date. If your patch file
has no date, WSCHANGE determines that you’re upgrading and won’t patch
specific labels. For a list of these labels, see the previous section in this booklet
called “Using the Udate Label.”

SAVING YOUR CUSTOMIZATIONS

Follow the steps below to save the customizations in your current version of
WordStar.

1 Atthe WSCHANGE Main Menu, press E (Patching).

Note: Other choices are available in WSCHANGE for saving screen color
and path settings.

2 At the Patching Menu, press B (Save settings) and type a filename for the
patch file to which you want your customizations saved.

3  Type Y to save the entire user area, or type N and specify the label for the in-
formation you want to save.

4 Press AX and then Y to save your changes and exit WSCHANGE.

COPYING THE PATCH FILE
Now, copy the patch file to your WordStar program file.

7 Atthe WSCHANGE Main Menu, press E (Patching).

3-19



ADVANCED CUSTOMIZING

2 Atthe Patching Menu, press A (Auto-patcher), type the name of the patch
file you want to copy, and press Enter. You can specify a drive and path in
the patch filename.

3 Press any key to return to the Patching Menu, and press AX and then Y to
save your changes and exit WSCHANGE.

W ORDSTAR AND ITS PATHS

When WSSETUP is run to install WordStar, most files go into the WordStar direc-
tory (usually WS). Some features are installed in separate directories and certain
paths are set for the files. These features and their default paths are shown below.
WORDSTAR FILES lists the files that WordStar accesses on the path. No files are
listed next to ProFinder since WordStar doesn’t access ProFinder files.

FEATURE PATH WORDSTAR FILES
WordStar \WS WSHELP.OVR, WSMSGS.OVR,

WSDSPCH.OVR, WSSTYLE.OVR,
WSHOTKEY.OVR, WSC.EXE,

WSD.EXE

Preview \WS PREVIEW.OVR, *.CRT,
FONTID.CTL

Dictionaries \WS WSSPLO00.OVR, SPLMN000.DCT,

PERSONAL.DCT, EXCEPT.DCT,
SPLINO00.DCT, WSTHS000.OVR,
THESRO00.DCT, DEFINOOO.DCT

Macros \WS\MACROS  *.WSM

Fax \WS\FAX *PCX

PostScript \WS WSPROL.PS, WSPROL2.PS
Inset \WS\INSET INSET.EXE

Graphics \WS\INSET TOPIX.EXE, TOPIX.SET
Conversion

MailList \WS\OPTIONS  WSLIST.COM



FEATURES PATH
ProFinder \WS\OPTIONS
TelMerge \WS\OPTIONS

Star Exchange \WS\CONVERT

WORDSTAR AND ITS PATHS

WORDSTAR FILE

None

TELMERGE.EXE, TELMERGE.SYS
CONVERT.EXE

Some features are grouped together and given different path numbers, even

though the paths may be the same:

FEATURE

Program and other files
not mentioned below

Dictionaries (not overlays)
Preview

Inset

TelMerge

MailList

Graphics conversion
PostScript

Fax

Star Exchange

Macros

PATH
Path 1 \WS)

Path 2 \WS)

Path 3 \WS)

Path 4 \WS\INSET)

Path 5 \WS\OPTIONS)
Path 6 \WS\OPTIONS)
Path 7 \WS\INSET)

Path 8 \WS)

Path 9 (\WS\FAX)

Path 10 AWS\CONVERT)
Path 11 AWS\MACROS)

When you run Inset, either when printing or by choosing Utilities=>Inset (Alt+U, |)
at the Editing screen, WordStar changes to the drive and directory specified in
path 4, loads Inset, and returns to the original drive and directory. The same
path is used when you select pix files (*.PIX) by choosing Insert=>Graphic (Alt+,G)
at the Editing screen. This method is also used when you convert graphics, use
macros, or run TelMerge, MailList, or Star Exchange from the Opening screen.

PRIMARY AND SECONDARY PATHS

In WSCHANGE you can specify primary and secondary paths for all WordStar
files. WordStar looks first for files on the primary path and then searches the
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secondary path. Primary and secondary paths are very useful if you're running
WordStar in a network environment.

When you install WordStar as a single user, WordStar assigns all files to secon-
dary paths. As a result, you can set up a customized directory and specify a
primary path for the files on that directory. WordStar searches for files in your
customized directory before it searches the secondary path.

SPECIFYING PRIMARY AND SECONDARY PATHS

Follow the steps below to specify primary and secondary paths in WSCHANGE.

1

At the WSCHANGE Main Menu, press C (Computer) then D (WordStar files).
The primary and secondary paths are shown in parentheses following the
WordStar filenames. In the example below, the primary path is “U” and the
secondary path is “3.” “U” means uninstalled—no path is assigned.

F Preview Filec.sssss cnwms swass smmms §sm e PREVIEW.OVR (U/3)

Note: You can examine or change the default paths by pressing A at
WordStar Files Menu #1.

At the WordStar Files Menu, press the command for the file whose path you

want to change.

For example, at the WordStar Files Menu #2, press G to change the primary
and secondary paths for the macro description files (*.WSM).

At the filename prompt, type a new filename or press Enter if you want to
accept the current filename.

At the primary path menu, choose the primary path or press X to continue
without changing.

At the secondary path menu, choose the secondary path or press X to con-
tinue without changing.

Press AX and then Y to save your changes and exit WSCHANGE.
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Usine ppFEDIT

You can use PDFEDIT to create custom PDFs for printers that WordStar doesn’t
support, or to make changes to PDFs for supported printers (for example, to add
a sheet feeder that WordStar doesn’t support).

When you use PDFEDIT, you'll type the codes your printer uses for print
enhancements. Check your printer manual very carefully for the correct code
sequences.

CAUTION PDFEDIT is an extremely technical program that should be
used only by very experienced printer users. Before you begin working in
PDFEDIT, make copies of the PDFs you plan to edit. Then, if you make a
mistake, you can restore your original PDFs.

To use PDFEDIT, you must have installed a printer and created a PDF. You
can install a printer similar to yours and modify the PDF to fit your printer, or
you can install for CUSTOM or SIMPLE to create a generic CUSTOM or
SIMPLE PDF.

To start PDFEDIT, follow the steps below for your type of computer.

1 Logon to your WordStar directory (usually WS).

2 Type pdfedit and press Enter.

3 Atthe first screen, press any key to continue.

4 Move the highlighting to the PDF you want to modify and press Enter.
You’ll see the PDF Editor Main Menu.

Note: If the display in PDFEDIT isn't clear, exit the program and type
pdfedit /m and press Enter. The program will use a monochrome display.

If you need help at any time in PDFEDIT, press F1.
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ENTERING PRINTER CODES

You can enter codes in most areas of PDFEDIT using ASCII control code nota-
tion. Control code notation uses a caret (*) followed by a character for the first
32 values (00-1F hex). To convert hex or decimal values to ASCII, see the
“ASCIl Conversion Charts” in the Reference manual.

EDITING CUSTOM AND SIMPLE PDFS

Before you can customize a CUSTOM or SIMPLE PDF, you must use
PRCHANGE to create it. Choose CUSTOM or SIMPLE from the Printer
Selection Menu.

The SIMPLE PDF really is simple. As it encounters print codes in the text, it
sends the control sequence you defined for that code to the printer. SIMPLE
makes one pass through the line from left to right. On some printers, interac-
tions may occur between the various print controls, so if the SIMPLE PDF
doesn’t produce the results you want, try the CUSTOM PDF.

The CUSTOM PDF is more sophisticated than the SIMPLE PDF in that it usually
compensates for a missing control sequence. For example, if you don’t define

control sequences for turning bold on and off, the CUSTOM PDF will overstrike
the line several times, but the SIMPLE PDF won't print bold at all.

GETTING AROUND IN PDFEDIT

PDFEDIT lets you customize many areas of a PDF. If you’re modifying a PDF
that already works with your printer, just change the items you want to adjust.

The chart on the next two pages shows the menu structure of PDFEDIT.
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USING PDFEDIT

| Print ID information

(Do not change)

I Vertical positioning

1 T

Relative (down/up) positioning
VM definition

Absolute vertical positioning
Page length definition

Vertical positioning type
Vertical points per inch

Horizontal positioning

Relative (left/right) positioning
Intercharacter space positioning
HMI positioning

Absolute positioning

Graphics positioning
Horizontal dots per inch
Directional movement strings

Control strings

Portrait orientation

Landscape orientation

Form feed string

Carriage return/line feed string
Carriage return only string

Job init string

Doc init string

(Menu 1)

Doc de-init string (Menu 2)
Job de-init string

Quit job string

Off-line (pause) string

Delay before job init/dnit/quit strings

Delay after job init/dnit/quit strings

Printer delay wait delay

| Attribute control

Superscript (Menu 1)
Subscript

Bold

Underline

Double strike

Strikeout (Menu 2)
Italic

Double underscore

Overscore

End of line mask

Miscellaneous control

Number of strikes for emulated bold
Number of strikes for emulated double strike
Microjustification value

Microjustification type

Underscore emulation character

Double underscore character

Character alignment type

Form feed type

Pause between pages
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PDFEDIT MENU STRUCTURE (Continued)

Color definitions

Color name
Select string

I:-» Typestyle/font information

> Choose a typestyle to modify

Name

Key (## and characteristics)

[ Edit font size to modify

Choose a font size to modify

—

IR}

Type width name
Average width
Font height

Regular
Bold
Italic

Bold ltalic
Graphics

NORMAL FONT:

SUPER/SUBSCRIPT FONT:

and press Enter.

Choose a font to modify

Miscellaneous font strings menu
Miscellaneous font values menu
Proportional width table menu
Database key

Kerning table menu

Style definition

Scalable font definition menu

SUBSTITUTION TABLES:
Character translation table menu
Character set selection table menu
Composed character table menu

Inset driver name

.PRD filename

Additional modification

Printer output device
Handshake protocol
ETX count

Background print speed
Page/nonpage type
Custom printer codes
Sheet feeder description
Sheet feeder trays
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* (multiplication operator), for patching, 3-17

—+

(addition operator), for patching, 3-17

- (subtraction operator), for patching, 3-17
. (display user area changes), 3-16

/(

A

division operator), for patching, 3-17

(move around in user area), 3-15 to 3-16
(or operator), for patching, 3-17

" (change digits to ASCII in user area), 3-16
| (and operator), for patching, 3-17
76 (hard to soft carriage return), auto-align and,

A

2-47

abandon changes. See cancel changes
add

custom fonts to PDF, 2-4, 2-19, 2-21 to 2-22

fonts to custom database, 2-4, 2-12 to 2-13,
2-19 to 2-21

fonts to FONTID.CTL, 3-5 to 3-10

fonts to PDF, 2-8, 2-11 to 2-12, 2-16 to 2-22

program files to documents (AP!), 2-14, 2-23
to 2-24

Add cartridge fonts option (Add or Delete Fonts

Menu), 2-16

Add fonts from custom database option (Add or

Delete Fonts Menu), 2-22

Add fonts to custom database (LSRFONTS)

option (WINSTALL Menu), 2-4, 2-19,
2-20 to 2-21

Add internal fonts option (Add or Delete Fonts

Menu), 2-16, 2-17

Additional Installation Menu, 2-8, 2-9
addition operator (+), for patching, 3-17
Add or delete font groups option (Additional

Installation Menu), 2-9

Add or Delete Fonts Menu, 2-12
Add or delete fonts option (PDF Modification
Menu), 2-11 to 2-12, 2-16, 2-17, 2-21
Add or Remove a Feature option (WINSTALL
Menu), 2-4, 2-6 to 2-7
Add or Remove a Feature screen (WSSETUP), 1-2
Add soft fonts option (Add or Delete Fonts
Menu), 2-17 to 2-18
Adobe Font Foundry, 3-13
Advanced Page Preview. See Preview
AFM files, 2-19, 2-20
alignment, 2-36, 2-38, 2-47
alternate font, 2-36
alternate palettes, 2-37
and operator (1), for patching, 3-17
arithmetic operators, for patching, 3-17
ARROW.HP, 2-25
ASC256 PDF, 2-14
ASClI files, with printer codes, 2-14
ASCII PDF, 2-14
ASCIl symbol set, screen fonts and, 3-9
ASPECT= statement (FONTID.CTL), 3-3
auto-align, 2-36, 2-38
auto backspace characters, 2-36
auto-backup, 2-36
AUTOEXEC.BAT, 1-4, 2-6, 2-28
AutoFont support files, 2-19, 2-25
auto-hyphenation, 2-36, 2-37
automatically fill out last record, 2-36
automatic leading, 2-36, 2-40
auto-patcher
copy settings, 2-37
turn on/off, 2-36
UDATE and, 3-18
using, 3-19 to 3-20
auto-switch programs, for laser printers, 2-28

INDEX - 1
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B

AB (strip MSB in nondocument), 2-47
background color, change for Preview, 3-4
background printing
speed of, 2-13, 2-29, 2-30
turn on/off, 2-34, 2-36
backup files, 2-36
“Bad command or filename” message, 2-15
batch file, for soft font download, 2-15
baud rate, for serial printers, 2-28
beep if printer wait condition, 2-36
beeping, turn on/off, 2-36, 2-41
bidirectional printing, 2-36
binding space character, 2-36
bins (paper), 2-13, 2-24
blank lines, suppress, 2-46
blocks, 2-36
.bn (select paper bin), 2-13, 2-24
booklets, printing on PostScript printers, 2-26
BORDER.PS, 2-26
bottom margin, 2-36
BOX.PS, 2-26 to 2-27
buffer flush control, for type ahead buffer, 2-47
buffer size
endnote buffer, 2-39
footnote buffer, 2-40
general buffer, 2-37
header and footer buffer, 2-40
macro hot key buffer, 2-42
messages and menus buffer, 2-42
spelling main buffer, 2-46
unerase buffer, 2-47
busy test for printer, 2-29, 2-44
busy time-out, 2-42

C

AC (cancel WSCHANGE changes and exit),
2-36
cables (printer), testing, 2-28 to 2-29
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cancel changes
in WSCHANGE and exit (*C), 2-36
See also exit
“Can’t find that file” prompt, 2-37
carriage returns
ending character for, 2-40, 2-45
hard returns to soft returns, auto-align and,
2-47
cartridge fonts
add or delete, 2-11 to 2-12, 2-16 to 2-17,
2-18 to 2-22
Preview or fax, 3-12
centimeter grids, 3-4
Change custom printer code option (PDF
Madification Menu), 2-13
Change printer adapter port option (PDF
Modification Menu), 2-13
Change print-time settings option (PDF
Modification Menu), 2-15
characters, change defaults for, 2-37
character sets, onscreen. See code pages
Check CONFIG.SYS file option (WINSTALL), 2-6
checkerboard, print on HP Laserlet, 2-25
CHEX.HP, 2-25
classic commands, turn display on/off, 2-37
code pages, 2-25, 2-37, 3-7
color monitors
background color in Preview, 3-4
customize settings, 2-5, 2-37, 2-45
endnote color, 2-39
footnote color, 2-40
preset colors, 2-5, 2-37, 2-45
reverse colors, 3-4
See also monitors
color printers, testing, 2-19
column settings, 2-37
command tags display, 2-37, 2-44
communications program. See TelMerge
companion programs, install/remove, 1-2, 1-5,
2-4,2-6 to 2-7
compressed files, decompress, 1-5



compressed fonts, 3-8, 3-12
computer patches, 2-37
See also patching
concurrent printing. See background printing
CONFIG.SYS, 1-2, 1-4, 2-6
continuous underlining, 2-37
\CONVERT, 3-21
convert files. See Star Exchange
CONVERT.EXE, 3-21
COPYWS, 1-5
COURIER screen font group, 3-6
Create download batch file option (PDF
Moadification Menu), 2-15
Create preview screen fonts option (PDF
Moadification Menu), 2-14
creeping text on page, 2-32
.CRT files, 3-10, 3-20
CRTs. See monitors
CRT_TYPE= statement (FONTID.CTL), 3-3
cursor movement, 1-2, 2-37, 2-40, 2-47
cursor sizes, 2-37
cursor type ahead, 2-39
cursor wrap on pull-downs, 2-44
custom fonts, 2-4, 2-12 to 2-13, 2-18 to 2-22
customize WordStar, 1-3, 2-1 to 2-22, 2-34 to
2-48, 3-1 to 3-26
add or remove companion programs, 2-4,
2-6to 2-7
directories/paths, 3-20 to 3-22
editing defaults, 2-4, 2-5 to 2-6
fax files, 3-10to 3-13
memory management, 2-33 to 2-34
monitors, 2-4 to 2-5, 2-42 to 2-43, 2-45,
2-47
patching WordStar, 3-13 to 3-20
Preview, 3-1to 3-10
printers, 2-3, 2-10 to 2-22, 3-23 to 3-26
WordStar settings, 2-34 to 2-48
Customize WordStar (WSCHANGE) option
(WINSTALL Menu), 2-4, 2-34 to 2-48
CUSTOM PDF, 3-23, 3-24

INDEX

Custom Printer Code dialog box, 2-23
custom printer codes, 2-13 to 2-14, 2-23 to 2-24

D

daisy wheel printers, 2-29, 2-30
See also printers
data item separator, 2-37
date format, 2-37
DEBUG, test printer cable and connection with,
2-28 to 2-29
decimal point character, 2-37
decimal tab stops, 2-37
decompress files, 1-5
Default paragraph style option (WINSTALL), 2-5
Default printer option (WINSTALL), 2-6
default settings
change, 2-34 to 2-48
code page, 2-25, 2-37
for editing, 2-4, 2-5 to 2-6
listed, 2-36 to 2-48
printer, 2-6, 2-9, 2-37, 2-44
screen fonts, 2-18
symbol set, 3-9
DEFIN000.DCT, 3-20
definitions during spelling session, 2-38
delays, 2-38, 2-42
DELCRT, 3-10
delete
companion programs, 2-4, 2-6 to 2-7
.CRT files, 3-10
fonts from PDF, 2-8, 2-11 to 2-12
PDFs, 2-15
See also Add or delete; Add or Remove
Del key, change function of, 2-38
dialog boxes
change defaults for, 2-38
Enter key function in, 2-6, 2-38, 2-39
dictionaries
change defaults for, 2-38, 2-39, 2-41, 2-44
directory/path for, 3-20, 3-21
exceptions dictionary, 2-39
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dictionaries (continued)
international dictionary, 2-41
personal dictionary, 2-44, 3-20
directories
change defaults for, 2-38, 3-21 to 3-22
defaults listed, 2-38, 3-20 to 3-21
initial logged directory, 2-6, 2-38
See also paths
disk access pause, 2-38
Disk Drive Name screen (WSSETUP), 1-2
disk drives, change defaults for, 2-38
disk space, turn display on/off, 2-38
dispatch table, 2-38
DISPFONT, 3-2, 3-5, 3-8 to 3-9, 3-11 to 3-13
display problems. See monitors, unclear
display; troubleshooting, screen font
problems
“Divide Overflow” message, 1-4
division operator (/), for patching, 3-17
documents, add program files to (*P!), 2-14,
2-23to 2-24
dollar format, 2-38
DOS
AUTOEXEC.BAT, 1-4, 2-6, 2-28
CONFIG.SYS, 1-2, 1-4, 2-6
MODE command, 2-13, 2-28
Run a DOS command prompt, 2-45
See also directories; paths
dot commands
.bn (select paper bin), 2-13, 2-24
change default settings for, 2-38 to 2-39,
2-47
.x| 00 (overprint a page), 2-24
dot leader character, 2-39
dot matrix printers, 2-29, 3-5
See also printers
double word check, 2-37
downloaded fonts. See soft fonts
DRAFT PDF, 2-29
DTR protocol, for PostScript printers, 2-26, 2-29
.DTU files, 2-19, 2-20
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E

editing
BOX.PS file, 2-27
default settings for, 2-4, 2-5 to 2-6
FONTID.CTL, 3-2 to 3-5
patch files, 3-17 to 3-18
PDFs, 3-23 to 3-26
Editor, memory allocation for, 2-39
Edit screen, change defaults for, 2-39
EHANDLER.PS, 2-33
EMS, 2-33, 2-39, 2-42
endnotes, 2-39
end of file character, 2-39
end of line character, 2-39
Enter key
dialog boxes and, 2-6, 2-38
move to next byte in user area, 3-16
Enter key in dialog boxes option (WINSTALL),
2-6
equal sign (=), move around in user area, 3-15
to 3-16
error messages
“Bad command or filename”, 2-15
buffer size for, 2-42
“Divide Overflow”, 1-4
“Printer may not be ready”, 2-30
print messages on PostScript printers, 2-33
“Stack Overflow”, 1-4
“You've selected too many fonts”, 2-31
See also messages; prompts
Esc key, change function of, 2-39
EXCEPT.DCT, 2-39, 3-20
exit
WordStar, 1-3
WSCHANGE, 2-36
expanded memory, 2-33, 2-39, 2-42
extended character set, screen fonts and, 3-7




F

%F"filename” (add custom printer code), 2-14
F1 (help). See help
families of fonts, 2-13
fast typing, 2-39
fax files
change defaults for, 2-39
directory/path for, 3-20, 3-21
resolution for, 3-5
screen fonts for, 2-14 to 2-15, 3-10 to 3-13
top and left offsets and, 3-5
FAX_RES= statement (FONTID.CTL), 3-5
file conversion. See Star Exchange
files
change defaults for, 2-39, 2-47
decompress, 1-5
See also directories; fax files; paths
FILES= statement (CONFIG.SYS), 1-4
find and replace, change defaults for, 2-39
flag column display, 2-39
Font Foundry (Adobe), 3-13
FONTID.CTL, 2-14, 2-40, 3-1 to 3-10, 3-20
fonts

add
custom fonts to PDF, 2-4, 2-19, 2-21 to
2-22
to custom database, 2-4, 2-12 to 2-13,
2-19 to 2-21

to FONTID.CTL, 3-5 to 3-10
to PDF, 2-8, 2-11 to 2-12, 2-16 to 2-22
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fonts (continued)

endnote font, 2-39, 2-40

families of, 2-13

for fax files, 2-14 to 2-15, 3-10 to 3-13

footnote font, 2-40

internal fonts, 2-11 to 2-12, 2-16 to 2-17,
3-12

larger than 72 points, 2-14

letter spacing problems on HP LaserJets,
2-32 to 2-33

line numbering font, 2-40, 2-41

LSRFONTS, 2-4, 2-19, 2-20 to 2-21

naming, 2-21 ‘

for Preview, 2-14 to 2-15, 2-18, 3-5 to 3-13

scalable fonts, 2-15, 2-19, 3-8, 3-12

screen fonts, 2-14 to 2-15, 2-18, 3-5 to 3-13

soft (downloaded) fonts, 2-4, 2-11 to 2-13,
2-15, 2-17 to 2-22, 2-31, 3-8

symbol sets and, 3-7, 3-9, 3-10 to 3-11

wrong fonts appear in printed document, 2-31

“You've selected too many fonts” message,
2-31

footers and headers, 2-40 to 2-41
footnotes, 2-40
form feeds

character for, 2-15, 2-40
creeping text on page and, 2-32

alternate font, 2-36

batch file for soft font download, 2-15

cartridge fonts, 2-11 to 2-12, 2-16 to 2-17,
2-18to 2-22, 3-12

change defaults, 2-39 to 2-40

compressed fonts, 3-8, 3-12

custom fonts, 2-4, 2-12 to 2-13, 2-18 to 2-22

delete from PDF, 2-8, 2-11 to 2-12

DISPFONT, 3-2, 3-5, 3-8 to 3-9, 3-11 to 3-13

garbled output, from printer, 2-30
general exclusion list file for Indexer, 2-40
go to top of page (*Ql), 2-40
graphics conversions

change defaults for, 2-40

directory/path for, 3-20, 3-21
graphics files, change defaults for, 2-40
graphics program. See Inset
gray background, print on HP Laserjet, 2-25
GRID_TYPE= statement (FONTID.CTL), 3-4
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H

AH
erase left in patcher, 3-16
move left, 2-47
hard carriage returns. See carriage returns
hard disk computers, install WordStar on, 1-1 to
1-3
headers and footers, 2-40 to 2-41
height of lines. See leading
height of screen, 2-45
help
levels of, 2-5, 2-41
overlay file for, 2-41
in PDFEDIT (F1), 3-23
in PRCHANGE (F1), 2-16
in WSCHANGE (F1), 2-35
Help level option (WINSTALL), 2-5
Hewlett Packard Laserjet. See HP Laserjets and
compatible printers
hexadecimal patches. See patching
horizontal unit of measure, 2-41
.HP files, 2-25
HP Laserjets and compatible printers, 2-24 to
2-25
code pages and, 2-25
compressed fonts (Series II-P), 3-8, 3-12
font matching and symbol sets, 2-32 to 2-33
letter spacing problems, 2-32 to 2-33
margins and, 2-23
overprinting pages, 2-24
program files, 2-23 to 2-25
sample program files, 2-25
scalable fonts (Series Ill), 2-15, 2-19, 3-8, 3-12
screen font creation using LaserJet soft fonts,
3-8, 3-12
soft fonts, 2-12, 2-18 to 2-22, 3-8
symbol sets and, 2-12, 2-32 to 2-33
See also laser printers
hyphenation, 2-34, 2-41
HYPINO000.DCT, 2-41
HYPMNO000.DCT, 2-41
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IBM 4019 and 4029
code pages and, 2-25
soft fonts, 2-12, 2-18 to 2-22
See also laser printers
IBM compatible ROM BIOS, turn on/off, 2-45
IBM counter/timer for beeping, 2-41
IBM PC monitor options, 2-4 to 2-5, 2-43
inch grids, 3-4
indexing, change defaults for, 2-40, 2-41
initial logged directory, 2-6, 2-38
Initial logged directory option (WINSTALL), 2-6
insert toggle, 2-41
Inset
change defaults for, 2-41
directory/path for, 3-20, 3-21
memory and, 2-33, 2-34
INSET.EXE, 2-41, 3-20
install
companion programs, 1-2, 1-5, 2-4, 2-6 to 2-7
MailList, 1-5, 2-4, 2-6 to 2-7
monitors, 1-2, 2-3, 2-4 to 2-5
printers, 1-2, 1-3, 2-3, 2-7 to 2-10
ProFinder, 2-4
sheet feeders, 2-8, 2-9, 2-13
Star Exchange, 1-5, 2-4, 2-6 to 2-7
TelMerge, 2-6 to 2-7
WordStar, 1-1 to 1-3
Install a monitor option (WINSTALL Menu),
2-3,2-4 to 2-5
Installed Printer Menu, 2-11, 2-15
Install Printer Menu, 2-7, 2-9
Install sheet feeder option (Additional
Installation Menu), 2-9
INT 1C timer interrupt, 2-41
internal fonts
add or delete, 2-11 to 2-12, 2-16 to 2-17
Preview or fax, 3-12
international characters, 2-37, 2-41, 2-42
international dictionary file, 2-41
INVERSE= statement (FONTID.CTL), 3-4



J

justification, 2-41, 2-42

K

kerning, 2-41
KEYBOARD.MRG, 2-44
keyboard repeat rate, 2-41

L

landscape mode, PostScript printers, 2-26
language, change defaults for, 2-41
laptops
with monochrome VGA LCD display, 3-3
underlining and, 2-5
LaserJets. See HP LaserJets and compatible
printers
laser printers
auto-switch programs, 2-28
margins and, 2-23
program files, 2-23 to 2-24
sheet feeders, 2-8, 2-9, 2-13, 2-32
See also fonts; HP LaserJets and compatible
printers; IBM 4019 and 4029;
PostScript printers; printers; Xerox
4045
last record, automatically fill out, 2-36
leading
automatic, 2-36, 2-41
VMI units for line height, 2-47
left margin, 2-41
left offset, for Preview, 3-4 to 3-5
legal pleadings, print on HP LaserJet, 2-25
legal-size paper
for PostScript printers, 2-26
preview document on, 3-4
LETTER.PS, 2-26
letter spacing problems, for HP Laser]ets, 2-32
to 2-33
line height. See leading

line numbering, 2-41 to 2-42

line spacing, 2-42

logged directory, 2-6, 2-38

logical operators, for patching, 3-17
LOGO.PS, 2-26

long busy time-out, 2-42

longest delay, 2-42

long line character, 2-42

Lotus international characters, 2-42
LSRFONTS, 2-4, 2-19, 2-20 to 2-21

M

INDEX

macros
change defaults for, 2-42
directory/path for, 3-20, 3-21
MailList
change defaults for, 2-42
directory/path for, 3-20, 3-21
install/remove, 1-5, 2-4, 2-6 to 2-7
margins
bottom margin, 2-36
footnotes and endnotes, 2-42
headers and footers, 2-40
laser printers and, 2-23
left margin, 2-41
line numbering, 2-41 to 2-42
paragraphs, 2-44
right margin, 2-45
top margin, 2-46
measurement units. See units of measure
memory, 2-42
allocation for Editor, 2-39
EMS, 2-33, 2-39, 2-42
increasing available, 2-33 to 2-34
video RAM, 2-45
memory-resident programs
WordStar and, 1-4
WordStar as, 2-45 !
menus
Additional Installation Menu, 2-8, 2-9
Add or Delete Fonts Menu, 2-12
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menus (continued)
buffer size for, 2-42
Installed Printer Menu, 2-11, 2-15
Install Printer Menu, 2-7, 2-9
levels of, 2-42
patching menus, 3-15 to 3-16, 3-19 to 3-20
PDFEDIT menu map, 3-25 to 3-26
PDF Modification Menu, 2-11 to 2-15
PRCHANGE menu map, 2-11
Printer Busy Handshaking Menu, 2-29
Printer Information Menu, 2-9
Printer Selection Menu, 2-8, 2-9, 2-26, 2-29
Printer Type Menu, 2-8, 2-9, 2-29
WSCHANGE menu map, 2-35
See also WINSTALL Menu
merge print, change defaults for, 2-42
messages
buffer size for, 2-42
change defaults for, 2-42
“Printer may not be ready”, 2-30
“Print Wait”, 2-30
See also error messages; prompts
microjustification, 2-42
MODE command (DOS), 2-13, 2-28
Modify AUTOEXEC.BAT option (WINSTALL), 2-6
Modify or install a printer (PRCHANGE) option
from WINSTALL Menu, 2-3, 2-7 to 2-22
See also PRCHANGE; printer description
files (PDFs)
Modify sheet feeder option (PDF Modification
Menu), 2-13
monitors
change defaults for, 2-43, 2-45, 2-47
install, 1-2, 2-3, 2-4 to 2-5
specify for Preview, 3-3
speed of display, 2-4, 2-5
types supported, 2-4 to 2-5
unclear display
in PDFEDIT, 3-23
snow removal, 2-4
in WINSTALL, 2-3, 2-20
in WordStar, 2-4
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monitors (continued)
See also color monitors
monochrome monitors, 2-5, 2-43, 3-3
See also monitors
monochrome VGA cards, 3-3
mouse, change defaults for, 2-43
MSB, strip in nondocument files (AB), 2-47
.MTR files, 2-20
multiplication operator (*), for patching, 3-17
multi-user systems. See networks

N

AN (split line/hard return to soft), 2-47
naming

font groups, 2-21

PDFs, 1-2, 2-13
near letter quality printing, 2-43
networks

downloadable font problems, 2-31

network option on/off, 2-43

printer not printing, 2-27
newspaper column file type, 2-43
nondocument files

change defaults for, 2-43

with printer codes, 2-14

strip MSB in (*B), 2-47
notes. See endnotes; footnotes
NPSHLYV screen font group, 3-6
numbering

lines, 2-41 to 2-42

pages, 2-43

0]

offset. See page offset

online help. See help

onscreen character sets. See code pages
onscreen fonts. See screen fonts
\OPTIONS, 3-20 to 3-21

or operator (M), for patching, 3-17




outline style numbering, 2-43
overprinting pages, 2-24
overprint line character, 2-43

P

AP! (add program file to document), 2-14, 2-23
to 2-24
AP? (change printer), 2-30
PAGE= statement (FONTID.CTL), 3-4
page breaks, 2-43
Page Down key, 1-2
page length, 2-43
page numbers, 2-43
page offset
change default, 2-43
set for Preview, 3-4 to 3-5
Page preview. See Preview
page size, in Preview, 3-4
page top. See top of page
palettes
alternate, 2-37
See also color monitors
paper bins, 2-13, 2-24
PAPER_COLOR= statement (FONTID.CTL), 3-4
paragraphs, change defaults for, 2-44
paragraph styles, 2-5, 2-44
patching, 3-13 to 3-20
caution about, 3-13
commands for, 3-16
computer patches, 2-37
copy patch files, 3-19 to 3-20
create and edit patch files, 3-17 to 3-18
from previous WordStar versions, 3-13,
3-18, 3-19
increasing available memory and, 2-34
menus for, 3-15 to 3-16, 3-19 to 3-20
monitor patches, 2-43
overview, 3-13
PATCH.LST file and, 3-13, 3-14 to 3-15
printer patch area, 2-44
save changes, 3-16, 3-19

INDEX

patching (continued)
special characters, 2-46
transfer patches to other WordStar copies,
3-19to 3-20
UDATE label and, 3-18
user area and, 3-14
See also auto-patcher
PATCH.LST, 3-13
PATCHLST.EXE, 3-14
paths
change defaults for, 2-44, 3-21 to 3-22
defaults listed, 2-44, 3-20 to 3-21
search paths, 2-37 to 2-38
specify primary and secondary, 3-21 to 3-22
to WSCHANGE options, 2-36 to 2-48
for WordStar directory in AUTOEXEC.BAT, 2-6
See also directories
pause between pages, 2-15
PC-8 symbol set, screen fonts and, 3-7, 3-8,
3-9, 3-11
PC-850 symbol set, screen fonts and, 3-7, 3-8,
3-1
.PCXfiles, 3-5, 3-20
PDFEDIT, 3-23 to 3-26
PDF Modification Menu, 2-11 to 2-15
PDFs. See printer description files (PDFs)
APE (custom printer code), 2-13, 2-24
PECHO.COM, 2-15
period (.), display user area changes, 3-16
PERSONAL.DCT, 2-44, 3-20
APF (custom printer code), 2-13, 2-24
APG (custom printer code), 2-13, 2-24
Pg Dn key, 1-2
/pgsize variable (WSPROL.PS), 2-26
pica grid, 3-4
.PIX files, 3-21
PLEAD.HP, 2-25
ports
printer not printing and, 2-28, 2-30
redirect printer output, 2-29
specify/change, 2-8, 2-9, 2-13, 2-28
See also serial ports
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Postscript Generic (PS:2 Up) option (Printer
Selection Menu), 2-26
PostScript printers, 2-25 to 2-27
booklet printing on, 2-26
directory/path for files, 3-20, 3-21
DTR protocol, 2-29
error message printing on, 2-33
landscape mode, 2-26
legal-size paper, 2-26
margins and, 2-23
overprinting pages, 2-24
program files, 2-23 to 2-24, 2-25 to 2-27
program listings printed on, 2-26
protocols, 2-26, 2-29
sample program files, 2-26 to 2-27
screen font creation using PostScript fonts,
3-13
soft fonts, 2-12, 2-18 to 2-22
testing, 2-10, 2-26
time-out error, 2-33
See also laser printers; serial ports
APQ (custom printer code), 2-13, 2-24
APR (custom printer code), 2-13, 2-24
PRCHANGE, 2-3, 2-7 to 2-22
customize a printer, 2-3, 2-10 to 2-22
help (F1), 2-16
install a printer, 2-3, 2-7 to 2-10
menu map, 2-11
screen font creation in, 2-14 to 2-15, 2-18,
3-5,3-7,3-8
Preview
change defaults for, 2-44
change display for, 3-3 to 3-5
code pages and, 2-25, 3-7
directory/path for, 3-20, 3-21
editing FONTID.CTL, 3-2 to 3-5
fine-tuning, 3-1 to 3-10
maximum screen font file size, 3-10
monitor specification for, 3-3
screen fonts for, 2-14 to 2-15, 2-18, 3-5 to
3-13
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troubleshooting screen font problems, 3-9 to
3-10
PREVIEW.OVR, 2-44, 3-20
print control (command tags) display, 2-37, 2-44
Printer Busy Handshaking Menu, 2-29
Printer Data, 2-8
Printer Data Files, mark for copying, 1-2
printer description files (PDFs)
add custom fonts to, 2-4, 2-19, 2-21 to 2-22
add fonts to, 2-8, 2-11 to 2-12, 2-16 to 2-22
change default file extension for, 2-44
CUSTOM PDF, 3-23, 3-24
delete, 2-15
delete fonts from, 2-8, 2-11 to 2-12
described, 2-7
modify (customize), 2-10 to 2-15, 3-23 to 3-26
naming, 1-2, 2-13
sheet feeders and, 2-13
SIMPLE PDF, 3-23, 3-24
Printer Information Menu, 2-9
“Printer may not be ready” message, 2-30
printers
auto-switch programs, 2-28
beep if printer wait condition, 2-36
cable and connection test, 2-28 to 2-29
change (*P?), 2-30
change default, 2-5, 2-6, 2-37, 2-44
change default settings for, 2-44
creeping text on page, 2-32
customize, 2-3, 2-10 to 2-22, 3-23 to 3-26
custom printer codes, 2-13 to 2-14, 2-23 to
2-24
default printer, 2-6, 2-9, 2-37, 2-44
default settings for, 2-44
form feeds, 2-15, 2-40
garbled output, 2-30
install, 1-2, 1-3, 2-3, 2-7 to 2-10
not on Printer Selection Menu, 2-8, 2-29
not printing, 2-27 to 2-29, 2-30
patch area, 2-44
protocols, 2-13, 2-26, 2-29



printer (continued)
redirect output, 2-29
testing, 2-10, 2-26, 2-28 to 2-29
troubleshooting problems, 2-27 to 2-33
types supported, 2-8
See also daisy wheel printers; dot matrix
printers; fonts; laser printers; ports;
printer description files (PDFs);
printing; serial ports; sheet feeders
Printer Selection Menu, 2-8, 2-9, 2-26, 2-29
Printer Type Menu, 2-8, 2-9, 2-29
printing
background (concurrent)
speed of, 2-13, 2-29, 2-30
turn on/off, 2-34, 2-36
bidirectional, 2-36
busy test for output to printer, 2-29, 2-44
error messages on PostScript printers, 2-33
long busy time-out, 2-44
merge print, 2-42
near letter quality, 2-43
overprinting pages, 2-24
pause between pages, 2-15
speed of, 2-13, 2-29, 2-30
See also printers
print-time settings, 2-15
PRINT.TST, 2-10
“Print Wait” message, 2-30
ProFinder
directory/path for, 3-21
install/remove, 2-4
program files
add to documents (AP!), 2-14, 2-23 to 2-24
HP LaserJets and compatible printers, 2-24
to 2-25
PostScript printers, 2-23 to 2-24, 2-25 to 2-27
program listings, printing on PostScript printers,
2-26
prompts
“Can’t find that file”, 2-37
“Return to WordStar”, 2-44
Run a DOS command prompt, 2-45
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prompts (continued)
“Words checked”, 2-47
See also messages
proportional spacing, 2-44
protocols
PostScript printers, 2-26, 2-29
printers, 2-13
PRVIEW PDF, 2-14
.PSfiles, 2-25 to 2-27
PSPRINT.TST, 2-10, 2-26
pull-downs, cursor wrap on/off, 2-44
APW (custom printer code), 2-13, 2-24

Q

QI (go to top of page), 2-47

AQU (align), 2-47

quit. See cancel changes; exit

quote mark (') (change digits to ASCII in user
area), 3-16

AQX (go to right side of screen), 2-47

R

R8 emulation options, 2-16, 2-18
RAM. See memory
RAM-resident programs. See memory-resident
programs
README, 1-5
record, last, automatically fill out, 2-36
redirect printer output, 2-29
remove. See Add or delete; Add or Remove;
delete
Rename current PDF option (PDF Modification
Menu), 2-13
reset all settings, 2-45
resolution
for fax files, 3-5
of screen fonts, 3-8
Return to Installed Printer Menu option (PDF
Modification Menu), 2-15
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“Return to WordStar” prompt, 2-44

reverse colors, 3-4

right margin, 2-45

ROM BIOS, IBM compatible, turn on/off, 2-41,
2-45

ruler lines, 2-39, 2-40, 2-41, 2-45

Run a DOS command prompt, 2-45

)

save
change defaults for, 2-45
changes in WSCHANGE and exit (*X), 2-36
patching changes, 3-16, 3-19
scalable fonts, 2-15, 2-19, 3-8, 3-12
screen character sets, 2-25
screen dimensions, 2-45
screen display problems. See monitors, unclear
display; troubleshooting, screen font
problems
screen fonts, 2-14 to 2-15, 3-5 to 3-13
add existing, 3-9
create, 2-14 to 2-15, 2-18, 3-5, 3-7 to 3-9,
3-11to 3-13
default, 2-18
duplicate, 3-9
for fax files, 2-14 to 2-15, 3-10 to 3-13
how Preview selects, 3-7
maximum file size for, 3-8, 3-10
overview, 3-5to 3-6
resolution of, 3-8
symbol sets and, 3-7, 3-8, 3-9, 3-10 to 3-11
troubleshooting problems, 3-9 to 3-10
scroll bar, 2-45
scrolling speed, 2-45
searching, change defaults for, 2-39
search paths, 2-37 to 2-38
Select printer adapter port option (Additional
Installation Menu), 2-9
separator between data items, 2-45
Serial Number screen (WSSETUP), 1-2
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serial ports
assigning, 2-8, 2-13
mode statement and, 2-13, 2-28
PDF customization and, 2-13
protocols for, 2-26
serial printers. See PostScript printers; serial
ports
Set basic editing defaults option (WINSTALL
Menu), 2-4
SETDTR.PS, 2-26, 2-29
SHADE.HP, 2-25
sheet feeders
creeping text on page and, 2-32
install, 2-8, 2-9, 2-13
sign-on message, 2-45
SIMPLE PDF, 3-23, 3-24
single quote (') (change digits to ASCI! in user
area), 3-16
single user system, 2-45
smallest word checked, 2-45
snaking column character, 2-45
snow on monitor, 2-4
soft carriage returns. See carriage returns
soft fonts
add or delete, 2-11 t0 2-12, 2-17 to 2-18
add or delete custom, 2-4, 2-12 to 2-13,
2-18 to 2-22
batch file for download, 2-15
compressed, 3-8
scalable, 2-15, 2-19, 3-8
screen fonts and, 3-8
troubleshooting, 2-31
soft spaces, 2-46
sort order, 2-46
spacing
letter spacing problems on HP LaserJets,
2-32to 2-33
line spacing, 2-42
proportional spacing, 2-44
speed
of display, 2-4, 2-5
of printing, 2-13, 2-29, 2-30




speed (continued)
of scrolling, 2-45
of WordStar, 2-33
spelling check, change defaults for, 2-38, 2-42,
2-46
spillover of text, 2-46
SPLIN000.DCT, 2-41, 3-20
SPLMNO000.DCT, 2-38, 2-42, 3-20
“Stack Overflow” message, 1-4
STACKS= statement (CONFIG.SYS file), 1-4
Star Exchange
directory/path for, 3-21
install/remove, 1-5, 2-4, 2-6 to 2-7
start
PDFEDIT, 3-23
WINSTALL, 2-3
WordStar, 1-3
WSCHANGE, 2-34 to 2-35
status line, 2-46
stop. See cancel changes; exit
strikeout character, 2-46
strip MSB in nondocument files (AB), 2-47
style bar, 2-46
style sheets. See paragraph styles
subscripts
font for, 2-13
roll for, 2-46
subtraction operator (-), for patching, 3-17
superscripts
font for, 2-13
roll for, 2-46
SUPERVCA cards, 3-3
suppress blank lines, 2-46
symbol sets
code pages and, 2-25
default set, 3-9
for fax file screen fonts, 3-10 to 3-11
for HP Laseret lll printers, 2-21
HP Laserjet font matching and, 2-32 to
2-33
screen fonts and, 3-7, 3-8, 3-9, 3-10 to
3-11

INDEX

T

tab stops, 2-46
TelMerge
change defaults for, 2-46
directory/path for, 3-21
install/remove, 2-6 to 2-7
TELMERGE.EXE, 2-46, 3-21
TELMERGE.SYS, 2-46, 3-21
temporary files, 2-46
testing printers, 2-10, 2-26, 2-28 to 2-29
text creeping on page, 2-32
text spillover, 2-46
.TFMfiles, 2-20
thesaurus, change defaults for, 2-46
THESR000.DCT, 3-20
thousands number separator, 2-46
time format, 2-46
time-out error, PostScript printers, 2-33
TIMES screen font group, 3-6
title bar display, 2-46
TOPIX.EXE, 2-40, 3-20
TOPIX.SET, 2-40, 3-20
top margin, 2-46
top offset, for Preview, 3-4 to 3-5
top of page, go to (*Ql), 2-40
transfer patches, 3-19 to 3-20
troubleshooting
printer problems, 2-27 to 2-33
screen font problems, 3-9 to 3-10
See also monitors, unclear display
TSR programs. See memory-resident programs
type ahead buffer flush control, 2-47
Type Director, 2-15, 2-19, 3-8, 3-12
typing, fast, 2-39

U

UDATE label, for patching, 3-18
underlining

continuous, 2-37

monitor installation and, 2-5
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unerase, change defaults for, 2-47

units of measure, 2-41, 2-42, 2-47

UNIVERS screen font group, 3-6

unzip files, 1-5

upgrade instructions, for patching, 3-13, 3-18,
3-19to 3-20

USASCII symbol set, screen fonts and, 3-7, 3-8,
3-10to 3-11, 3-13

user area (WS.EXE), 3-14 to 3-15

\Y

variable name indicator, 2-47

VER= statement (FONTID.CTL), 3-9, 3-10
vertical unit of measure, 2-47

VESA BIOS drivers, 3-3

VGA cards, 3-3

video attributes, 2-47

video RAM, put characters directly in, 2-47
VMI units for line height, 2-40, 2-47

W

windows, change defaults for, 2-47
WINSTALL
overview, 1-3, 2-1
start, 2-3
unclear display in, 2-3, 2-20
WINSTALL Menu, 2-3 to 2-4
Add fonts to custom database (LSRFONTS)
option, 2-4, 2-19, 2-20 to 2-21
Add or remove a feature option, 2-4, 2-6 to
2-7
Customize WordStar (WSCHANGE) option,
2-4,2-34 t0 2-48
Install a monitor option, 2-3, 2-4 to 2-5
Modify or install a printer (PRCHANGE)
option, 2-3, 2-7 to 2-22
Set basic editing defaults option, 2-4
words, smallest word checked, 2-45
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“Words checked” prompt, 2-47
WordStar
exit, 1-3
install, 1-1to 1-3
speed of, 2-33
start, 1-3
WordStar compatibility, 2-47
word wrap, 2-47
\WS, 3-20 to 3-21
WSC.EXE, 2-42, 3-20
WSCHANGE, 2-4, 2-34 to 2-48
cancel changes and exit (*C), 2-36
EMS and, 2-33
exit, 2-36
help (F1), 2-35
menu map, 2-35
overview, 2-34 to 2-35
patching user area, 3-15 to 3-16
path specification in, 3-21 to 3-22
paths to WSCHANGE options, 2-35 to 2-48
save changes and exit (AX), 2-36
start, 2-34 to 2-35
WSD.EXE, 2-42, 3-20
WSDSPCH.OVR, 2-38, 3-20
WS.EXE, user area, 3-14 to 3-15
.WSF files, 2-14, 3-2, 3-5 to 3-6, 3-8
WSHELP.OVR, 2-41, 3-20
WSHOTKEY.OVR, 2-42, 3-20
WSHYP000.OVR, 2-41
WSINDEX.XCL, 2-40, 2-41
WSLIST.COM, 2-42, 3-20
.WSM files, 3-20
WSMIN.PAT, 2-33 to 2-34
WSMSGS.OVR, 2-42, 3-20
WSPROL2.PS, 3-20
WSPROL.PS, 2-26, 2-33, 3-20
WSSETUP, 1-1 to 1-3
WSSPL0O00.OVR, 2-46, 3-20
WSSTYLE.OVR, 2-44, 3-20
WSTHS000.0VR, 3-20




X

Y
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X (save patching changes), 3-16
X (save WSCHANGE changes and exit), 2-36
Xerox 4045

soft fonts, 2-12, 2-18 to 2-22

See also laser printers
xI 00 (overprint a page), 2-24
XON/XOFF protocol, for PostScript printers, 2-26
XTRACT PDF, 2-14

“You've selected too many fonts” message, 2-31

YA

zipped files, unzip, 1-5
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